
4.media and tray
This chapter provides information on how to load print media into your machine.
This chapter includes:
• Selecting print media
• Changing the tray size
• Loading paper in the tray

• Printing on special media
• Changing the tray size

  

Selecting print media
You can print on a variety of print media, such as plain paper, envelopes, 
labels, and transparencies. Always use print media that meets the 
guidelines for use with your machine and from the appropriate tray. 

Guidelines for selecting the print media
Print media that does not meet the guidelines outlined in this user’s guide 
may cause the following problems:
• Poor print quality
• Increased paper jams
• Premature wear on the machine.
• Permanent fuser damage, not covered under warranty.
Properties, such as weight, composition, grain, and moisture content, are 
important factors that affect the machine’s performance and the output 
quality. When you choose print materials, consider the following:
• The type, size and weight of the print media for your machine are 

described in print media specifications. (See "Print media specifications" 
on page 61.)

• Desired outcome: The print media you choose should be appropriate for 
your project.

• Brightness: Some print media are whiter than others and produce 
sharper, more vibrant images.

• Surface smoothness: The smoothness of the print media affects how 
crisp the printing looks on the paper.

 

• Some print media may meet all of the guidelines in this section and 
still not produce satisfactory results. This may be the result of the 
sheets characteristics, improper handling, unacceptable 
temperature and humidity levels, or other variables over which 
cannot be controlled.

• Before purchasing large quantities of print media, ensure that it 
meets the specifications in this user’s guide and that it meets your 
output requirements. 

 

• Using print media that does not meet these specifications may 
cause problems, requiring repairs. Such repairs are not covered by 
the warranty or service agreements.
The amount of paper put into the tray may differ according to 
media type used. (See "Print media specifications" on page 61.)

• Using inflammable print media can cause a fire.
• Use designated print media (See "Print media specifications" on 

page 61).

 

The use of inflammable media or foreign materials left in the printer 
may lead to overheating of the unit and, in rare cases may cause a 
fire.

Media sizes supported in each mode
Mode Size Type Source

Simplex 
printing

For details about 
paper size, see 
"Print media 
specifications" 
on page 61.

For details about 
paper type, see 
"Print media 
specifications" 
on page 61.

Tray

Duplex 
printing 
(Manual)a

a.75 to 90 g/m2 (20~24 lbs bond) only (See "Print media specifications" 
on page 61).

Letter, A4, 
Legal, US Folio, 
Oficio

Plain, Color, 
Preprinted, 
Recycled, Bond, 
Archive

Manual feeding 
in the tray

Changing the tray size
The tray is preset to Letter or A4 size, depending on your country. To 
change the size, you need to adjust the paper guides.

1 Paper width guide
2 Tray
3 Paper length guide
Media and tray_ 27



1. Open front cover and pinch the paper length guide and pull it out to 
extend the tray.

 

Because the machine is very light, it can move when you open and 
close the tray or install and remove the toner cartridge. Be careful 
not to move the machine when performing these tasks.

2. Flex or fan the edge of the paper stack to separate the pages before 
loading the paper. Insert the paper into the tray.

3. Load paper with the print side facing up. Make sure that all four corners 
are flat in the tray.

 

Do not overload the tray with paper. Otherwise, it may cause paper 
jams.

4. Pinch the paper length guide to adjust the guide so that it is flush up 
against the rear edge of the paper; then pinch the paper width guides so 
they are flush against the sides of the paper.

 

• Do not push the paper width guide too far causing the media to 
warp. 

• Do not use a paper with more than 6 mm (0.24 inch.) curl. 
• If you do not adjust the paper width guide, it may cause paper 

jams.

Loading paper in the tray
Tray
1. Open the front cover, pinch the paper length guide and pull it out to 

extend the tray. Then, adjust the tray size to the media size you are 
loading. (See "Changing the tray size" on page 27.)

2. Flex or fan the edge of the paper stack to separate the pages before 
loading papers.

3. Place the paper with the side you want to print facing up.

When you print a document, set the paper type and size for the tray.
For information about setting the paper type and size on the control 
panel (See "Setting the default tray and paper" on page 26).

 

• If you experience problems with paper feeding, check whether 
the paper meets the media specifications. Then, try placing 
one sheet at a time in tray (See "Print media specifications" on 
page 61, "Printing on special media" on page 29).

• The settings made from the machine driver override the 
settings on the control panel.

Manual feeding in the tray
The tray can hold special sizes and types of print material, such as 
postcards, note cards, and envelopes. It is useful for single page printing on 
letterhead or colored paper.

Tips on using the manual feeding method
• If you select Paper > Source > Manual Feeder from your printer 

driver, you need to press  each time you print a page.
Load only one type, size and weight of print media at a time in the 
tray.

• To prevent paper jams, do not add media while printing. 
• Print media should be loaded face up with the top edge going into 

the tray first and be placed in the center of the tray.
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• Always load the use recommended print media to avoid paper jams 
and print quality problems. (See "Print media specifications" on 
page 61.)

• Flatten any curl on postcards, envelopes, and labels before loading 
them into the tray.

1. Load the paper in the tray.

 

• When printing on special media, you must follow the 
loading guideline. (See "Printing on special media" on 
page 29.)

• When paper does not feed well while printing, gently push 
the paper in manually until it starts feeding automatically. 

2. Squeeze the tray paper width guides and adjust them to the width of 
the paper. Do not force them too much, or the paper will bend 
resulting in a paper jam or skew.

3. Open the output support. 
4. To print from an application, open the application and open the print 

menu.
5. Open Printing Preferences. (See "Opening printing preferences" on 

page 33.)
6. Click on the Paper tab in Printing Preferences, and select an 

appropriate paper type.

 

For example, if you want to use a label, set the paper type to 
Label.

7. Select Manual Feeder in paper source, then press OK.
8. Start printing.

 

If you are printing multiple pages, load the next sheet after the first 
page prints out, and press the . Repeat this step for every page 
to be printed.

Printing on special media
The table below shows the available special media for printing. 

 

When printing on a special media, we recommend you feed one paper 
at a time. Check the maximum input number of media for tray. (See 
"Print media specifications" on page 61.)

Types tray Manual feeding 
in traya

Plain ● ●

Thick ● ●

Thin ● ●

Cotton ●

Color ●

Preprinted ●

Recycled ● ●

Envelope ●

Transparency ●

Labels ●

CardStock ●

Bond ●

Archive ● ●

(●: supported, Blank: Not supported) 
The following media types are shown in the Printing Preferences. This 
paper type option allows you to set the type of paper to be loaded in the 
tray. Selecting the appropriate media will let you get the best printout 
quality. Selecting inappropriate media can result in poor print quality.
• Plain: Normal plain paper. Select this type if your printing on 60 to 120 

g/m2 (16 to 32 lbs).
• Thick: 90 to 163 g/m2 (24 to 43 lbs) thick paper.
• Thin: 60 to 70 g/m2 (16 to 19 lbs) thin paper.
• Cotton: 75 to 90 g/m2 (20 to 24 lbs) cotton paper.
• Color: 75 to 90 g/m2 (20 to 24 lbs) color-back grounded paper.
• Preprinted: 75 to 90 g/m2 (20 to 24 lbs) preprinted/letterhead paper.
• Recycled: 60 to 90 g/m2 (16 to 24 lbs) recycled paper.

 

When you use recycled paper, printouts might be wrinkled and/or 
jamming may occur due to excessive curl. 

• CardStock: 105 to 163 g/m2 (28 to 43 lbs) cardstock. 
• Envelope: 75 to 90 g/m2 (20 to 24 lbs) envelope.
• Transparency: 138 to 146 g/m2 (37 to 39 lbs) transparency paper. 
• Labels: 120 to 150 g/m2 (32 to 40 lbs) labels. 
• Bond: 105 to 120 g/m2 (28 to 32 lbs) bond. 
• Archive: 70 to 90 g/m2 (19 to 24 lbs) If you need to keep the print-out 

for a long time, such as for archives. 

a.Load one paper at a time.

Types tray Manual feeding 
in traya
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Envelopes
Successful printing on envelopes depends upon the quality of the 
envelopes. 
To print on an envelope, the stamp area should be on the left side and the 
end of the envelope with the stamp area should enter the printer first in the 
center of the tray.

• When selecting envelopes, consider the following factors:
- Weight: The weight of the envelope paper should not exceed 

90 g/m2 otherwise, jams may occur.
- Construction: Prior to printing, envelopes should lie flat with less 

than 6 mm ( 0.24 inch.) of curl, and should not contain air.
- Condition: Envelopes should not be wrinkled, nicked, nor 

damaged.
- Temperature: Use envelopes that are compatible with the heat and 

pressure of the machine during operation.
• Use only well-constructed envelopes with sharp-and well-creased folds.
• Do not use stamped envelopes.
• Do not use envelopes with clasps, snaps, windows, coated lining, 

self-adhesive seals, or other synthetic materials.
• Do not use damaged or poorly made envelopes.
• Be sure the seam at both ends of the envelope extends all the way to 

the corner of the envelope.

1  Acceptable
2  Unacceptable

• Envelopes with a peel-off adhesive strip or with more than one flap that 
folds over to seal must use adhesives compatible with the machine’s 
fusing temperature about 170°C (338 °F) for 0.1 second. The extra flaps 
and strips might cause wrinkling, creasing, or jams, and may even 
damage the fuser.

• For the best print quality, position margins no closer than 15 mm ( 0.59 
inch.) from the edges of the envelope.

• Avoid printing over the area where the envelope’s seams meet.

Transparencies
To avoid damaging the machine, use only transparencies designed for laser 
printers.

• Transparencies used in the machine must be able to withstand 
machine’s fusing temperature.

• Place them on a flat surface after removing them from the machine.
• Do not leave unused transparencies on the paper tray for long periods of 

time. Dust and dirt may accumulate on them, resulting in spotty printing.
• To avoid smudging caused by fingerprints, handle transparencies 

carefully.
• To avoid fading, do not expose printed transparencies to prolonged 

sunlight.
• Ensure that transparencies are not wrinkled, curled, or have any torn 

edges.
• Do not use transparencies that separate from the backing sheet.
• To prevent transparencies from sticking to each other, do not let the 

printed sheets stack up as they are begin printed out. 

Labels
To avoid damaging the machine, use only labels designed for laser 
machines.

• When selecting labels, consider the following factors:
- Adhesives: The adhesive material should be stable at your 

machine’s fusing temperature (about 170°C (338 °F)). 
- Arrangement: Only use labels with no exposed backing between 

them. Labels can peel off sheets that have spaces between the 
labels, causing serious jams.

- Curl: Prior to printing, labels must lie flat with no more than 13 mm 
(0.51 inch.) of curl in any direction.

- Condition: Do not use labels with wrinkles, bubbles, or other 
indications of separation.

• Make sure that there is no exposed adhesive material between labels. 
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Exposed areas can cause labels to peel off during printing, which can 
cause paper jams. Exposed adhesive can also cause damage to 
machine components.

• Do not run a sheet of labels through the machine more than once. The 
adhesive backing is designed for only a single pass through the 
machine.

• Do not use labels that are separating from the backing sheet or are 
wrinkled, bubbled, or otherwise damaged.

Card stock/Custom-sized paper
Postcards, cards and other custom-sized materials can be printed with this 
machine.

• Do not print on media smaller than 76 mm (3.00 inches) wide or 183 mm 
(7.20 inches) long.

• In software applications, set the margins at least 6.4 mm (0.25 inches) 
away from the edges of the material.

Letterhead/Preprinted paper

Single-sided Double-sided

Face up Face down

• Letterhead/ Preprinted paper must be printed with heat-resistant ink that 
will not melt, vaporize, or release hazardous emissions when subjected 
to the machine’s fusing temperature (about 170°C(338 °F) for 0.1 
second. 

• Letterhead/ Preprinted paper ink must be non-flammable and should not 
adversely affect machine rollers.

• Forms and letterhead should be sealed in a moisture-proof wrapping to 
prevent changes during storage.

• Before you load letterhead/preprinted paper, verify that the ink on the 
paper is dry. During the fusing process, wet ink can come off preprinted 
paper, reducing print quality.

Using the output support

 

The surface of the output tray may become hot if you print a large 
number of pages at once. Make sure that you do not touch the 

surface, and do not allow children near it.

The printed pages stack on the output support, and the output support will 
help the printed pages to align. The printer sends printouts to the output tray 
by default.
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5.printing
This chapter explains common printing tasks.
This chapter includes:
• Printer driver features
• Basic printing
• Opening printing preferences
• Using help
• Using special print features

• Changing the default print settings
• Setting your machine as a default machine
• Printing to a file (PRN)
• Macintosh printing
• Linux printing

  

 

The procedures in this chapter are mainly based on Windows XP.

Printer driver features
Your printer drivers support the following standard features:
• Paper orientation, size, source, and media type selection
• Number of copies
In addition, you can use various special printing features. The following 
table shows a general overview of features supported by your printer driver:

 

Some models or operating systems may not support some of the 
feature(s) in the following table.

Printer driver
Feature Windows

Print quality option ●

Poster printing ●

Multiple pages per sheet ●

Booklet printing (manual) ●

Fit to page printing ●

Reduce and enlarge printing ●

Different source for first page ●

Watermark ●

Overlay ●

Double-sided printing (manual) ●

(●: supported) 

Basic printing
Your machine allows you to print from various Windows, Macintosh, or 
Linux applications. The exact steps for printing a document may vary 
depending on the application you use.

 

• Your Printing Preferences window that appears in this user’s 
guide may differ depending on the machine in use. However, the 
composition of the Printing Preferences window is similar. Check 
the operating system(s) that are compatible with your machine. 
Refer to the OS compatibility section of Printer Specifications. 
(See "System requirements" on page 22.) 

• When you select an option in Printing Preferences, you may see 
a warning mark, , or . An exclamation mark ( ) means you 
can select that certain option but it is not recommended, and ( ) 
mark means you cannot select that option due to the machine’s 
settings or environment.

The following procedure describes the general steps required for printing 
from various Windows applications. 

 

• Macintosh basic printing. (See "Macintosh printing" on page 37.)
• Linux basic printing. (See "Linux printing" on page 39.)

The following Printing Preferences window is for Notepad in Windows XP. 
Your Printing Preferences window may differ, depending on your 
operating system or the application you are using. 
1. Open the document you want to print.
2. Select Print from the File menu. The Print window appears. 
3. Select your machine from the Select Printer list.

You can select the basic print settings, including the number of copies 
and the print range from within the Print window. 

 

To take advantage of the printer features provided by your printer 
driver, click Properties or Preferences in the application’s Print 
window to change the print setting. (See "Opening printing 
preferences" on page 33.)

4. To start the print job, click OK or Print in the Print window.

 

The Samsung AnyWeb Print  will save your time for screen-captured 
images or printing the image. For Windows, click Start > All 
programs > Samsung Printers > Samsung AnyWeb Print to link 
the website where the tool is available for the download. For 
Macintosh, click Application > Samsung > Samsung AnyWeb 
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Print.

Canceling a print job
If the print job is waiting in a print queue or print spooler, cancel the job as 
follows:
1. Click the Windows Start menu.
2. For Windows 2000, select Settings > Printers.

• For Windows XP/2003, select Printer and Faxes. 
• For Windows 2008/Vista, select Control Panel > Hardware and 

Sound > Printers. 
• For Windows 7, select Control Panel > Hardware and Sound > 

Devices and Printers. 
• For Windows Server 2008 R2, select Control Panel > Hardware > 

Devices and Printers. 
3. For Windows 2000, XP, 2003, 2008 and Vista, double-click your 

machine.
For Windows 7 and Windows Server 2008 R2, right click your printer 
icon > context menus > See what’s printing.

 

If See what’s printing item has a ► mark, you can select other 
printer drivers connected with selected printer.

4. From the Document menu, select Cancel.

 

You can also access this window by simply double-clicking the 
machine icon ( ) in the Windows task bar. 

You can also cancel the current job by pressing  on the control 
panel.

Opening printing preferences
You can preview the settings you selected on the upper right of the Printing 
Preferences.
1. Open the document you want to print.
2. Select Print from the file menu. The Print window appears. 
3. Select your machine from the Select Printer. 

4. Click Properties or Preferences. 

Using a favorite setting
The Presets option, which is visible on each of the preferences tab except 
for the Samsung tab, allows you to save the current preferences for future 
use. 
To save a Presets item:
1. Change the settings as needed on each tab. 
2. Enter a name for the item in the Presets input box.

3. Click Add. When you save Presets, all current driver settings are saved.
If you click Add, the Add button changes to the Update button. Select more 
options and click Update, settings will be added to the Presets you made.
To use a saved setting, select it from the Presets drop-down list. The 
machine is now set to print according to the settings you have selected.
To delete saved settings, select it from the Presets drop-down list and click 
Delete. 
You can also restore the printer driver’s default settings by selecting Default 
Preset from the Presets drop-down list.
Printing_ 33



Using help
Click the question mark on the upper-right corner of the window and click on 
the topic you want to know about. Then a pop up window appears with 
information about that option's feature which is provided from the driver. 

If you want to search information via a keyword, click the Samsung tab in 
the Printing Preferences window, and enter a keyword in the input line of 
the Help option. To get information about supplies, driver updates or 
registration and so on, click appropriate buttons.

Using special print features
Special print features include:
• "Printing multiple pages on one sheet of paper" on page 34.
• "Printing posters" on page 34.
• "Printing booklets (Manual)" on page 34.
• "Printing on both sides of the paper (Manual)" on page 34.
• "Change percentage of your document" on page 35.
• "Fitting your document to a selected paper size" on page 35.
• "Using watermarks" on page 35.
• "Using overlays" on page 36.
• "Print quality options" on page 36.

Printing multiple pages on one sheet of paper
You can select the number of pages to print on a single sheet of paper. To 
print more than one page per sheet, the pages will be reduced in size and 
arranged in the order you specify. You can print up to 16 pages on one 
sheet. 
1. To change the print settings from your software application, access 

Printing Preferences. (See "Opening printing preferences" on 
page 33.)

2. Click the Basic tab, select Multiple Pages Per Side in the Type 
drop-down list.

3. Select the number of pages you want to print per sheet (2, 4, 6, 9, or 16) 
in the Pages per Side drop-down list.

4. Select the page order from the Page Order drop-down list, if necessary. 
5. Check Print Page Border to print a border around each page on the 

sheet.
6. Click the Paper tab, select the Size, Source, and Type.
7. Click OK or Print until you exit the Print window.

Printing posters
This feature allows you to print a single-page document onto 4, 9, or 16 
sheets of paper, for the purpose of pasting the sheets together to form one 
poster-size document.

1. To change the print settings from your software application, access 
Printing Preferences. (See "Opening printing preferences" on 
page 33.)

2. Click the Basic tab, select Poster Printing in the Type drop-down list.
3. Select the page layout you want.

Available layouts:
• Poster 2x2: Document will be enlarged and be divided into 4 pages.
• Poster 3x3: Document will be enlarged and be divided into 9 pages.
• Poster 4x4: Document will be enlarged and be divided into 16 

pages.
4. Select the Poster Overlap value. Specify Poster Overlap in millimeters 

or inches by selecting the radio button on the upper right of Basic tab to 
make it easier to paste the sheets together.

5. Click the Paper tab, select the Size, Source, and Type.
6. Click OK or Print until you exit the Print window.
7. You can complete the poster by pasting the sheets together.

Printing booklets (Manual)
This feature prints your document on both sides of a paper and arranges the 
pages so that the paper can be folded in half after printing to produce a 
booklet.

 

If you want to make a booklet, you need to print on Letter, Legal, A4, 
US Folio, or Oficio sized print media. 

8 9

1. To change the print settings from your software application, access the 
Printing Preferences. (See "Opening printing preferences" on 
page 33.)

2. Click the Basic tab, select Booklet Printing from the Type drop-down 
list.

3. Click the Paper tab, select the Size, Source, and Type.

 

The Booklet Printing option is not available for all paper sizes. In 
order to find out the available paper size for this feature, select the 
available paper size in the Size option on the Paper tab.
If you select an unavailable paper size, this option can be 
automatically canceled. Select only available paper. (paper without 

 or  mark).
4. Click OK or Print until you exit the Print window.
5. After printing, fold and staple the pages.

Printing on both sides of the paper (Manual)
You can print on both sides of a paper (duplex). Before printing, decide how 
you want your document oriented. You can use this feature with Letter, 
Legal, A4, US Folio, or Oficio sized paper. (See "Print media specifications" 
on page 61.)

 

We recommend not to print on both sides of special media, such as 
labels, envelopes, or thick paper. It may cause a paper jam or damage 
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the machine. 

1. To change the print settings from your software application, access 
Printing Preferences. (See "Opening printing preferences" on 
page 33.)

2. Click the Advanced tab.
3. From the Double-Sided Printing (Manual) section, select the binding 

option you want.   
• None
• Long Edge: This option is the conventional layout used in 

bookbinding.

• Short Edge: This option is the conventional layout used in 
calendars.

4. Click the Paper tab, select the Size, Source, and Type.
5. Click OK or Print until you exit the Print window.

 

If your machine does not have a duplex unit, you should complete the 
printing job manually. The machine prints every other page of the 
document first. After that, a message appears on your computer. 
Follow the on-screen instructions to complete the printing job.

Change percentage of your document
You can change the size of a document to appear larger or smaller on the 
printed page by typing in a percentage you want.

1. To change the print settings from your software application, access 
Printing Preferences. (See "Opening printing preferences" on 
page 33.)

2. Click the Paper tab.
3. Enter the scaling rate in the Percentage input box.

You can also click the up/down arrows to select the scaling rate. 
4. Select the Size, Source, and Type in Paper Options. 
5. Click OK or Print until you exit the Print window.

Fitting your document to a selected paper size
This feature allows you to scale your print job to any selected paper size 
regardless of the document size. This can be useful when you want to 
check fine details on a small document. 

A

1. To change the print settings from your software application, access 
Printing Preferences. (See "Opening printing preferences" on 
page 33.)

2. Click the Paper tab.
3. Select the paper size you want from the Fit to Page.
4. Select the Size, Source, and Type in Paper Options. 
5. Click OK or Print until you exit the Print window.

Using watermarks
The watermark option allows you to print text over an existing document. 
For example, you use it when you want to have large gray letters reading 
“DRAFT” or “CONFIDENTIAL” printed diagonally across the first page or all 
pages of a document. 

There are several predefined watermarks that come with the machine. They 
can be modified, or you can add new ones to the list. 

Using an existing watermark
1. To change the print settings from your software application, access 

Printing Preferences. (See "Opening printing preferences" on 
page 33.)

2. Click the Advanced tab, and select the desired watermark from the 
Watermark drop-down list. You will see the selected watermark in 
the preview image. 

3. Click OK or Print until you exit the print window. 

Creating a watermark
1. To change the print settings from your software application, access 

Printing Preferences. (See "Opening printing preferences" on 
page 33.)

2. From the Advanced tab, select Edit from the Watermark drop-down 
list. The Edit Watermarks window appears. 

3. Enter a text message in the Watermark Message box. You can 
enter up to 256 characters. The message displays in the preview 
window.
When the First Page Only box is checked, the watermark prints on 
the first page only.

4. Select watermark options. 
You can select the font name, style, size, and shade from the Font 
Attributes section, as well as set the angle of the watermark from 
the Message Angle section. 

5. Click Add to add a new watermark to the Current Watermarks list.   
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6. When you have finished, click OK or Print until you exit the Print 
window.

To stop printing the watermark, select None from the Watermark 
drop-down list. 

Editing a watermark
1. To change the print settings from your software application, access 

Printing Preferences. (See "Opening printing preferences" on 
page 33.)

2. Click the Advanced tab, select Edit from the Watermark drop-down 
list. The Edit Watermarks window appears. 

3. Select the watermark you want to edit from the Current Watermarks 
list and change the watermark message and options. 

4. Click Update to save the changes.
5. Click OK or Print until you exit the Print window. 

Deleting a watermark
1. To change the print settings from your software application, access 

Printing Preferences. (See "Opening printing preferences" on 
page 33.)

2.  Click the Advanced tab, select Edit from the Watermark 
drop-down list. The Edit Watermarks window appears. 

3. Select the watermark you want to delete from the Current 
Watermarks list and click Delete. 

4. Click OK or Print until you exit the Print window.

Using overlays
An overlay is content you store on your hard disk drive that can be 
superimposed over any document you print. An overlay is often used to take 
the place of letterhead paper. Rather than using preprinted letterhead, you 
can create an overlay containing exactly the same information that is 
currently on your letterhead. To print a letter with your company’s 
letterhead, you do not need to load preprinted letterhead paper in the 
machine, instead you can just print the letterhead overlay on your 
document.

Creating a new overlay
To use a page overlay, you must create a new page overlay file 
containing your content.
1. Create or open a document containing the content you want to use in 

a new page overlay. Position the items exactly where you want them 
to appear when they are added to the original.

2. To save the document as an overlay, access Printing Preferences. 
(See "Opening printing preferences" on page 33.)

3. Click the Advanced tab, and select Edit from the Text drop-down 
list. The Edit Overlay window appears.

4. In the Edit Overlay window, click Create. 
5. In the Save As window, type a name of up to eight characters in the 

File name box. Select the destination path, if necessary. (The 
default is C:\Formover.)

6. Click Save. The name appears on the Overlay List. 
7. Click OK or Print until you exit the Print window.

8. The file is not printed. Instead, it is stored on your computer hard disk 
drive.

 

The overlay document size must match same as the document 
you print. Do not create an overlay with a watermark.

Using an overlay
After an overlay has been created, it is ready to be printed with your 
document. To print an overlay on your document:
1. Create or open the document you want to print.
2. To change the print settings from your software application, access 

Printing Preferences. (See "Opening printing preferences" on 
page 33.)

3. Click the Advanced tab. 
4. Select the desired overlay from the Text drop-down list. 
5. If the overlay file you want does not appear in the Text drop-down 

list, select Edit from the list and click Load. Select the overlay file 
you want to use. 
If you have stored the overlay file you want to use in an external 
source, you can also load the file when you access the Open 
window. 
After you select the file, click Open. The file appears in the Overlay 
List box and is available for printing. Select the overlay from the 
Overlay List box. 

6. If necessary, check Confirm Page Overlay When Printing box. If 
this box is checked, a message window appears each time you 
submit a document for printing, asking you to confirm that you wish 
to print an overlay over your document. 
If this box is not checked and an overlay has been selected, the 
overlay automatically prints with your document. 

7. Click OK or Print until you exit the Print window. 
The selected overlay prints over your document. 

 

The resolution of the overlay document must match the resolution 
of the original print job.

Deleting an overlay
You can delete page overlays that you no longer use. 
1. In the Printing Preferences window, click the Advanced tab. 
2. Select Edit in the Overlay drop down list. 
3. Select the overlay you want to delete from the Overlay List box. 
4. Click Delete. 
5. When the confirmation message window appears, click Yes.
6. Click OK or Print until you exit the Print window.

Print quality options
Use the following Graphics options to adjust the print quality for your 
specific printing needs.
1. To change the print settings from your software application, access 

Printing Preferences. (See "Opening printing preferences" on 
page 33.)

2. Click the Graphics tab.

 

• The options you can select may vary depending on your printer 
model. 

• Refer to the help for each option’s information provided from 
the Printing Preferences.

• Font/Text: Select Darken Text to print text darker than on a normal 
document. Use All Text Black to print solid black, regardless of the 
color it appears on the screen.
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• Graphic Controller: Fine Edge allows you to emphasize edges of 
texts and fine lines for improving readability.

• Toner Save: Selecting this option extends the life of your toner 
cartridge and reduces your cost per page without a significant 
reduction in print quality.
- Printer Setting: If you select this option, this feature is 

determined by the setting you’ve made from the machine (For 
some models, you cannot change the setting from the machine. 
In this case, the default setting is Off). 

- On: Select this option to allow the printer to use less toner on 
each page.

- Off:Select this option if you do not want to save toner when 
printing a document.

• Darkness: The option adjusts the toner density on print outputs. 
The values are Normal, Light, and Dark.

3. Click OK or Print until you exit the Print window.

Changing the default print settings

 

Most Windows applications will override settings you specify in the 
printer driver. Change all print settings available in the software 
application first, and change any remaining settings using the printer 
driver. 

1. Click the Windows Start menu. 
2. For Windows 2000, select Settings > Printers.

• For Windows XP/2003, select Printers and Faxes. 
• For Windows 2008/Vista, select Control Panel > Hardware and 

Sound > Printers. 
• For Windows 7, select Control Panel > Hardware and Sound > 

Devices and Printers. 
• For Windows Server 2008 R2, select Control Panel > Hardware > 

Devices and Printers. 
3. Right-click your machine.
4. For Windows XP/2003/2008/Vista, press Printing Preferences.

For Windows 7 and Windows Server 2008 R2, from context menus, 
select the Printing preferences.

 

If Printing preferences item has a ► mark, you can select other 
printer drivers connected with the selected printer.

5. Change the settings on each tab. 
6. Click OK.

 

If you want to change the settings for each print job, change it in 
Printing Preferences. 

Setting your machine as a default machine
1. Click the Windows Start menu.
2. For Windows 2000, select Settings > Printers.

• For Windows XP/2003, select Printers and Faxes. 
• For Windows 2008/Vista, select Control Panel > Hardware and 

Sound > Printers. 
• For Windows 7, select Control Panel > Hardware and Sound > 

Devices and Printers. 
• For Windows Server 2008 R2, select Control Panel > Hardware > 

Devices and Printers. 
3. Select your machine.
4. Right-click your machine and select Set as Default Printer.

 

For Windows 7 and Windows Server 2008 R2
If Set as default printer item has a ► mark, you can select other 
printer drivers connected with the selected printer.

Printing to a file (PRN)
You will sometimes need to save the print data as a file. 
To save a print job as a file:
1. Check the Print to file box at the Print window.

2. Click Print.
3. Type in the destination path and the file name, and then click OK. 

For example c:\Temp\file name.

 

If you type in only the file name, the file is automatically saved in 
My Documents and Settings or Users. The saved folder may 
differ depending on your operating system or the application you 
are using.

Macintosh printing
This chapter explains how to print using a Macintosh. You need to set the 
print environment before printing. 
• USB connected (See "Macintosh" on page 24.)

Printing a document
When you print with a Macintosh, you need to check the printer driver 
setting in each application you use. Follow the steps below to print from a 
Macintosh:
1. Open an application and select the file you want to print.
2. Open the File menu and click Page Setup (Document Setup in some 

applications).
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3. Choose your paper size, orientation, scaling, other options, and make 
sure that your machine is selected. Click OK.

4. Open the File menu and click Print. 
5. Choose the number of copies you want and indicate which pages you 

want to print. 
6. Click Print.

Changing printer settings
You can use advanced printing features provided by your machine.
Open an application and select Print from the File menu. The machine 
name, which appears in the printer properties window may differ depending 
on the machine in use. Except for the name, the composition of the printer 
properties pane is similar to the following.

 

• The setting options may differ depending on models and 
Macintosh OS versions.

• The following panes may differ, depending on your operating 
system or the application you are using.

The following pane is the first pane you will see when you open the printer 
properties pane. Select other advanced features from the drop down list. 

Layout
The Layout dialog provides options to adjust how the document 
appears on the printed page. You can print multiple pages on one sheet 
of paper. Select Layout from the drop-down list under Orientation to 
access the following features.
• Pages per Sheet: This option determines how many pages to be 

printed on one page. (See "Printing multiple pages on one sheet of 
paper" on page 38.)

• Layout Direction: This option allows you to select the printing 
direction on a page similar to the examples on UI.

• Border: This option allows you to print a border around each page 

on the sheet.
• Reverse Page Orientation: This option allows you to rotate paper 

180 degrees. 

Graphics
The Graphics dialog provides options for selecting Resolution. Select 
Graphics from the drop-down list under Orientation to access the 
graphic features.
• Resolution (Quality): This option allows you to select the printing 

resolution. The higher the setting, the sharper the clarity of printed 
characters and graphics. A higher setting will also increase the time 
it takes to print a document.

• Darkness: This option allows you to enhance the darkness of the 
printouts. The available options are Normal, Light, and Dark.

Printer Features
• Paper Type: Set paper type to correspond to the paper loaded in 

the tray from which you want to print. This will let you get the best 
quality printout. If you load a different type of print material, select the 
corresponding paper type.

Printer Settings
•Toner Save Mode: Selecting this option extends the life of your toner 

cartridge and reduces your cost per page without a significant 
reduction in print quality.
-Printer Setting: If you select this option, this feature is determined 

by the setting you’ve made from the machine (For some models, 
you cannot change the setting from the machine. In this case, the 
default setting is Off). 

-On: Select this option to allow the printer to use less toner on each 
page.

-Off: Set this option if you do not need to save toner when printing a 
document.

• Power Save: When you will not be using the machine for a while, 
you can use this feature to save power. Select a value from the 
drop-down list in Time Delay.

Printing multiple pages on one sheet of paper
You can print more than one page on a single sheet of paper. This feature 
provides a cost-effective way to print draft pages.
1. Open an application, and select Print from the File menu.
2. Select Layout from the drop-down list under Orientation. In the Pages 

per Sheet drop-down list, select the number of pages you want to print 
on one sheet of paper.

3. Select the other options you want to use.
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4. Click Print, then the machine prints the selected the number of pages 
you want to print on one sheet of paper.

Linux printing
Printing from applications
There are several Linux applications that allow you to print using the 
Common UNIX Printing System (CUPS). You can print using any of these 
applications.
1. Open an application, and select Print from the File menu.
2. Select Print directly using LPR.
3. From the LPR GUI window, select the model name of your machine from 

the printer list and click Properties.

4. Change the print job properties using the following four tabs displayed at 
the top of the window.

• General: This option allows you to change the paper size, the paper 
type, and the orientation of the documents. It enables the duplex 
feature, adds start and end banners, and changes the number of 
pages per sheet.

• Text: This option allows you to specify the page margins and set the 
text options, such as spacing or columns.

• Graphics: This option allows you to set image options that are used 

when printing images/files, such as color options, image size, or 
image position.

• Advanced: This option allows you to set the print resolution, paper 
source and special print features.

 

If an option is grayed out, it means that the grayed out option is not 
supported by your machine.

5. Click Apply to apply the changes and close the Properties window.
6. Click OK in the LPR GUI window to start printing.
7. The Printing window appears, allowing you to monitor the status of your 

print job.
To abort the current job, click Cancel.

Printing files
You can print many different types of files on your machine using the 
standard CUPS way, directly from the command line interface. The CUPS 
LPR utility allows you to do that. But the drivers package replaces the 
standard LPR tool by a much more user-friendly LPR GUI program.
To print any document file:
1. Type lpr <file_name> from the Linux shell command line and press 

Enter. The LPR GUI window appears.
When you type only lpr and press Enter, the Select file(s) to print 
window appears first. Just select any files you want to print and click 
Open.

2. From the LPR GUI window, select your machine from the list, and 
change the print job properties.

3. Click OK to start printing.

Configuring printer properties
Using the Printer Properties window provided by the Printers 
configuration, you can change the various properties for your printer.
1. Open the Unified Driver Configurator.

If necessary, switch to Printers configuration.
2. Select your machine from the available printers list and click Properties.
3. The Printer Properties window opens.

The following five tabs display at the top of the window:
• General: This option allows you to change the printer location and 

name. The name entered in this tab displays on the printer list in 
Printers configuration.

• Connection: This option allows you to view or select another port. If 
you change the machine port from USB to parallel or vice versa 
while in use, you must re-configure the machine port in this tab.

• Driver: Allows you to view or select another printer driver. By 
clicking Options, you can set the default device options.

• Jobs: This option shows the list of print jobs. Click Cancel job to 
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cancel the selected job and select the Show completed jobs check 
box to see previous jobs on the job list.

• Classes: This option shows the class that your machine is in. Click 
Add to Class to add your machine to a specific class or click 
Remove from Class to remove the machine from the selected 
class.

4. Click OK to apply the changes and close the Printer Properties 
window.
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6.management tools
This chapter introduces management tools provided to help you make full use of your machine. 
This chapter includes:
• Introducing useful management tools
• Using Samsung Easy Printer Manager (Windows only)
• Using Samsung Printer Status (Windows only)

• Using the Smart Panel program (Macintosh and Linux only)
• Using the Unified Linux Driver Configurator

  

Introducing useful management tools
The programs below help you to use your machine conveniently.
• "Using Samsung Easy Printer Manager (Windows only)" on page 41
• "Using Samsung Printer Status (Windows only)" on page 42
• "Using the Smart Panel program (Macintosh and Linux only)" on 

page 42.
• "Using the Unified Linux Driver Configurator" on page 43.

Using Samsung Easy Printer Manager (Windows 
only)
Samsung Easy Printer Manager is a Windows-based application that 
combines Samsung machine settings into one location. Samsung Easy 
Printer Manager combines device settings as well as printing environments, 
settings/actions and launching. All of these features provide a gateway to 
conveniently use your Samsung machine. 

 

Internet Explorer 6.0 or higher is the minimum requirement for 
Samsung Easy Printer Manager.

Understanding Samsung Easy Printer Manager
To open the program:
Select Start > Programs or All Programs > Samsung Printers > 
Samsung Easy Printer Manager > Samsung Easy Printer Manager. 

The Easy Printer Manager interface is comprised of various basic sections 
as described in the table that follows:

6

4

5

 21

3
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1 Printer List The printer list is displayed as icons.

 

2

Printer 
Information

This area gives you general information about your 
machine. You can check information, such as the 
machine’s model name, IP address (or Port name), 
and machine status.

 

User’s Guide button: This button opens 
Troubleshooting Guide when an error 
occurs. You can directly open the necessary 
section in the user’s guide. 

 

3

Application 
information

Includes links for changing to the advanced 
settings, preference, help, and about.

 The  button is used to change the user 
interface to the advanced settings user 
interface.

 

4
Quick links Displays Quick links to machine specific 

functions. This section also includes links to 
applications in the advanced settings.

 

5

Contents 
Area

Displays information about the selected machine, 
remaining toner level, and paper. The information 
will vary based on the machine selected. Some 
machines do not have this feature.

 

6
Order 
Supplies

Click on the Order button from the supply ordering 
window. You can order replacement toner 
cartridge(s) from online.

 

Click the Help ( ) button from the upper-right corner of the window 
and click on any option you want to know about. 

Using Easy Capture Manager
You can use the Easy Capture Manager program after installing 
Samsung Easy Printer Manager. Press Print Screen key on your 
keyboard. The Easy Capture Manager program appears. It helps you to 
gather screen fragments and to pack them in few pages instead of 
printing each fragment on a separate page, to print only you want to print 
and thus saving paper and toner.

Using Samsung Printer Status (Windows only)
The Samsung Printer Status is a program that monitors and informs you of 
the machine status. 

 

• The Samsung Printer Status window and its contents shown in this 
user’s guide may differ depending on the machine or operating 
system in use.

• Check the operating system(s) that are compatible with your 
machine (see Basic guide).

Samsung Printer Status overview
If an error occurs while operating, you can check the error from the 
Samsung Printer Status. Samsung Printer Status is installed automatically 
when you install the machine software. 
You can also launch Samsung Printer Status manually. Go to the Printing 
Preferences , click the Basic tab > Printer Status button.
These icons appear on the Windows task bar:

Icon Mean Description

Normal The machine is in ready mode and experiencing 
no errors or warnings.

Warning The machine is in a state where an error might 
occur in the future. For example, it might be in 
toner low status, which may lead to toner empty 
status. 

Error The machine has at least one error.

 

1

Toner Level You can view the level of toner remaining in 
each toner cartridge. The machine and the 
number of toner cartridge(s) shown in the 
above window may differ depending on the 
machine in use. Some machines do not have 
this feature.

 

2
Alert Settings Select the settings you want from the options 

window. 
 

3
Order Supplies You can order replacement toner cartridge(s) 

from online.
 

4
Troubleshooting You can directly open the troubleshooting 

section in the user’s guide.
 

5 Close Close the window.

Using the Smart Panel program (Macintosh and 
Linux only)
Smart Panel is a program that monitors and informs you of the machine 
status, and allows you to customize the machine’s driver settings. For 
Macintosh, Smart Panel is installed automatically when you install the 
machine software. For Linux, you can download the Smart Panel from the 
Samsung website (See "Installing the SmartPanel" on page 25).

 

To use this program, your computer has to meet the following system 
requirements:
• Mac OS X 10.3 or higher. Check that your computers CPU, RAM, 

and HDD meet or exceed spec. (See "System requirements" on 
page 22.)

• Linux. Check that your computers CPU, RAM, and HDD meet or 
exceed spec.
e. (See "System requirements" on page 22.)
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If you need to know the exact model number of your machine, you can 
check the supplied software CD.

Understanding Smart Panel
If an error occurs while printing, you can check the error from the Smart 
Panel.
You can also launch Smart Panel manually. Double-click the Smart Panel 
icon on the Notification Area (in Linux). 

Linux Click this icon in Linux.

 

• If you have already installed more than one Samsung machine, 
first select the correct machine model you want in order to access 
the corresponding Smart Panel.
Right-click (in Linux) the Smart Panel icon and select your 
machine.

• The Smart Panel window and its contents shown in this user’s 
guide may differ depending on the machine or operating system in 
use.

In  case of  Mac OS 10.3
1. Click ‘Print & Fax’ in System Preferences
2. Click ‘Set up Printers...’.
3. Select printer in list and double click it.
4. Click ‘Utility’.

In  case of  Mac OS 10.4
1. Click ‘Print & Fax’ in System Preferences
2. Select printer in list and click ‘Printer Queue…’.
3. Click ‘Utility’.

In  case of  Mac OS 10.5
1. Click ‘Print & Fax’ in System Preferences
2. Select printer in list and click ‘Open Printer Queue...’.
3. Click ‘Utility’.

In  case of  Mac OS 10.6
1. Click ‘Print & Fax’ in System Preferences
2. Select printer in list and click ‘Open Printer Queue...’.
3. Click ‘Printer Setup’.
4. Click ‘Utility ’ tab.
5. Click ‘Open Printer Utility’.

The Smart Panel program displays the current status of the machine, the 
level of toner remaining in the toner cartridge(s), and various other types of 
information. You can also change settings.

 

1

Toner Level View the level of toner remaining in the toner 
cartridge(s). The machine and the number of toner 
cartridge(s) shown in the above window may differ 
depending on the machine in use. Some machines 
do not have this feature.

 

2 Buy Now Order replacement toner cartridge(s) online.

 

3

User’s Guide View the User’s Guide.

 

This button changes to Troubleshooting 
Guide when error occurs. You can directly 
open the troubleshooting section in the 
user’s guide. 

Opening the Troubleshooting Guide
Find solutions for problems by using the Troubleshooting Guide. 
Right-click (in Linux) the Smart Panel icon and select Troubleshooting 
Guide.

Changing the Smart Panel Program Settings
Right-click (in Linux) the Smart Panel icon and select Options. Select the 
settings you want from the Options window. 

Using the Unified Linux Driver Configurator
The Unified Driver Configurator is a tool primarily intended for configuring 
machine devices. You need to install Unified Linux Driver to use Unified 
Driver Configurator (See "Installing the Unified Linux Driver" on page 24).
After the driver is installed on your Linux system, the Unified Driver 
Configurator icon will automatically be created on your desktop.

Opening the Unified Driver Configurator
1. Double-click the Unified Driver Configurator on the desktop.

You can also click the Startup Menu icon and select Samsung Unified 
Driver > Unified Driver Configurator.

2. Click each button on the left to switch to the corresponding configuration 
window.  

1 Printers 
Configuration 

2 Ports 
Configuration 

 

 To use the on screen help, click Help.
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3. After changing the configurations, click Exit to close the Unified Driver 
Configurator.

Printers configuration window
Printers configuration has the two tabs: Printers and Classes.

Printers tab
View the current system’s printer configuration by clicking on the 
machine icon button on the left side of the Unified Driver Configurator 
window.

 

1 Switches to Printers configuration.
 

2 Shows all of the installed machine.
 

3 Shows the status, model name and URI of your machine.

The printer control buttons are, as follows:
• Refresh: Renews the available machines list.
• Add Printer: Allows you to add a new machines.
• Remove Printer: Removes the selected machine.
• Set as Default: Sets the current selected machine as a default 

machine.
• Stop/Start: Stops/starts the machine.
• Test: Allows you to print a test page to ensure the machine is 

working properly.
• Properties: Allows you to view and change the printer properties. 

Classes tab
The Classes tab shows a list of available machine classes.

 

1 Shows all of the machine classes.
 

2
Shows the status of the class and the number of machines in the 
class.

• Refresh: Renews the classes list.
• Add Class: Allows you to add a new machine class.
• Remove Class: Removes the selected machine class.

Ports configuration
In this window, you can view the list of available ports, check the status of 
each port, and release a port that is stalled in a busy state when its owner 
has terminated the job for any reason.

 

1 Switches to Ports configuration.
 

2 Shows all of the available ports.
 

3 Shows the port type, device connected to the port, and status.
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• Refresh: Renews the available ports list.
• Release port: Releases the selected port.
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7.maintenance
This chapter provides information about maintaining your machine and the toner cartridge.
This chapter includes:
• Printing a machine report
• Cleaning a machine

• Storing the toner cartridge
• Tips for moving & storing your machine

  

Printing a machine report
You can print a configuration page to view current printer settings, or to help 
troubleshoot printer problems. 
(See "Printing a configuration sheet" on page 21.)

Cleaning a machine
If printing quality problems occur or if you use your machine in a dusty 
environment, you need to clean your machine regularly to keep the the most 
optimum print quality.

 

• Cleaning the outside of the machine with cleaning materials 
containing large amounts of alcohol, solvent, or other strong 
substances can discolor or distort the cabinet. 

• If your machine or the surrounding area is contaminated with 
toner, we recommend that you use a cloth or tissue dampened 
with water to clean it. If you use a vacuum cleaner, toner blows in 
the air and might be harmful if inhaled.

Cleaning the outside
Clean the machine cabinet with a soft, lint-free cloth. Dampen the cloth 
slightly with water, but be careful not to let any water drip onto or into the 
machine.

Cleaning the inside
During the printing process, paper dust, toner, and dust particles in the air 
can accumulate inside the machine. This buildup can cause print quality 
problems, such as toner specks or smearing. Cleaning the inside of the 
machine clears and reduces these problems.

1. Turn the machine off and unplug the power cord. Wait for the machine to 
cool down.

2. Open the top cover and pull the toner cartridge out. Set it on a clean flat 
surface.

 

• To prevent damage to the toner cartridge, do not expose it to 
light for more than few minutes. Cover it with a piece of paper, 
if necessary. 

• Do not touch the green surface of the drum located in the toner 
cartridge or imaging unit. Use the handle on the cartridge to 
avoid touching this area.

3. With a dry, lint-free cloth, wipe away any dust and spilled toner from the 
toner cartridge area.

 

While cleaning the inside of the machine, be careful not to damage 
the transfer roller or any other inside parts. Do not use solvents 
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such as benzene or thinner to clean. Printing quality problems can 
occur and cause damage to the machine.

4. Reinsert the toner cartridge and close the top cover.
5. Plug in the power cord and turn the machine on.

Storing the toner cartridge
Toner cartridges contain components that are sensitive to light, 
temperature, and humidity. Samsung suggests users follow the 
recommendations below to ensure the optimum performance, highest 
quality, and longest life from your new Samsung toner cartridge.
Store this cartridge in the same environment as the printer it will be used in; 
this should be in controlled office temperature and humidity conditions. The 
toner cartridge should remain in its original, unopened package until 
installation – If original packaging is not available, cover the top opening of 
the cartridge with paper and store it in a dark cabinet.
Opening the cartridge package prior to use dramatically shortens its useful 
shelf and operating life. Do not store on the floor. If the toner cartridge is 
removed from the printer, always store the cartridge according to the 
following guidelines:
• Inside the protective bag from the original package. 
• Store lying flat (not standing on end) with the same side facing up as if it 

was installed in the machine.
• Do not store consumable in any of the following conditions:

- Temperature greater than 40°C (104°F).
- Humidity range less than 20% and not greater than 80%.
- An environment with extreme changes in humidity or temperature.
- Direct sunlight or room light.
- Dusty places.
- A car for a long period of time.
- An environment where corrosive gases are present.
- An environment with salty air.

Handling instructions
• Do not touch the surface of the photoconductive drum in the cartridge.
• Do not expose the cartridge to unnecessary vibrations or shock.
• Never manually rotate the drum, especially in the reverse direction; this 

can cause internal damage and toner spillage.

Use of non-Samsung and refilled toner cartridge
Samsung Electronics does not recommend or approve the use of 
non-Samsung brand toner cartridges in your printer including generic, store 
brand, refilled, or remanufactured toner cartridges.

 

Samsung’s printer warranty does not cover damage to the machine 
caused by the use of a refilled, remanufactured, or non-Samsung 
brand toner cartridge.

Estimated cartridge life
Estimated cartridge life (the life of the toner cartridge yield) depends on the 
amount of toner that print jobs require. The actual print yield may vary 
depending on the print density of the pages you print on, operating 
environment, printing interval, media type, and/or media size. For example, 
if you print a lot of graphics, the consumption of the toner is high and you 
may need to change the cartridge more often.

Tips for moving & storing your machine
When moving the machine, do not tilt or turn it upside down. Otherwise, the 
inside of the machine may be contaminated by toner, which can cause 
damage to the machine or reduce print quality.
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8.troubleshooting
This chapter gives helpful information for what to do if you encounter an error.
This chapter includes:
• Redistributing toner
• Tips for avoiding paper jams

• Clearing paper jams
• Solving other problems

  

Redistributing toner
When the toner cartridge is near the end of its life:
• White streaks or light printing occurs. 
• The  LED blinks red. 
If this happens, you can temporarily improve print quality by redistributing 
the remaining toner in the cartridge. In some cases, white streaks or light 
printing will still occur even after you have redistributed the toner.
1. Open the top cover.
2. Pull the toner cartridge out.

3. Thoroughly roll the cartridge five or six times to distribute the toner 
evenly inside the cartridge.

 

If toner gets on your clothing, wipe it off with a dry cloth and wash 
clothing in cold water. Hot water sets toner into fabric.

 

Do not touch the drum in the the toner cartridge or imaging unit. 
Use the handle on the cartridge to avoid touching this area. 

4. Hold the toner cartridge by the handle and slowly insert the cartridge into 
the opening in the machine. 
The tabs on the sides of the cartridge and corresponding grooves within 
the machine will guide the cartridge into the correct position until it locks 

into place completely.

5. Close the top cover. Ensure that the cover is securely closed. 

Tips for avoiding paper jams
By selecting the correct media types, most paper jams can be avoided. 
When a paper jam occurs, refer to the guidelines below:
• Ensure that the adjustable guides are positioned correctly. (See 

"Loading paper in the tray" on page 28.)
• Do not overload the tray. Ensure that the paper level is below the paper 

capacity mark on the inside of the tray.
• Do not remove paper from the tray while your machine is printing.
• Flex, fan, and straighten paper before loading. 
• Do not use creased, damp, or highly curled paper.
• Do not mix paper types in a tray.
• Use only recommended print media.
• Ensure that the recommended side of the print media is facing the right 

side. (See "Loading paper in the tray" on page 28.)

• If duplexing, print one sheet at a time using the . (See "Printing on 
both sides of the paper (Manual)" on page 34.)

• If you are printing on a special paper, print one sheet at a time using the 

. (See "Manual feeding in the tray" on page 28.)

Clearing paper jams

If a paper jam occurs, the  LED on the control panel lights orange. Find 
and remove the jammed paper. 
To resume printing after clearing paper jams, you must open and close the 
top cover.
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To avoid tearing the paper, pull the jammed paper out slowly and 
carefully. Follow the instructions in the following sections to clear the 
jam. 

In tray 

 

Click this link to open an animation about clearing a jam.

1. Open and close the top cover. The jammed paper is automatically 
ejected from the machine. 
If the paper does not eject, go to the next step.

2. Remove the jammed paper by gently pulling it straight out.

If the paper does not move when you pull, or if you do not see the paper 
in this area, check inside the machine. (See "Inside the machine" on 
page 49.)

Inside the machine

 

Click this link to open an animation about clearing a jam.

 

The fuser area is hot. Be careful when removing paper from this area 
to prevent getting your fingers burnt.

1. Open and close the top cover. The jammed paper is automatically 
ejected from the machine. 
If the paper does not eject, go to the next step.

2. Open the top cover. 
3. Open the fuser unit cover.

.

4. Remove the jammed paper by gently pulling it straight out.

If you do not see the jammed paper, go to the next step.
5. Pull the toner cartridge out.

6. Remove the jammed paper by gently pulling it straight out.
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7. Insert the toner cartridge back into the machine.

8. Close the fuser unit cover. 
9. Close the top cover. Printing automatically resumes.

Solving other problems
The following chart lists some trouble conditions that may occur and the 
recommended solutions. Follow the suggested solutions until the problem is 
corrected. If the problem persists, contact a service representative.
Other problems include:
• See "Power problems" on page 50.
• See "Paper feeding problems" on page 51.
• See "Printing problems" on page 51.
• See "Printing quality problems" on page 53.
• See "Common Windows problems" on page 55.
• See "Common Linux problems" on page 55.
• See "Common Macintosh problems" on page 56.

Power problems

 

Click this link to open an animation about solving power problems.

Condition Suggested solutions

The machine is 
not receiving 
power, 
or the connection 
cable between the 
computer and the 
machine is not 
connected 
properly.

• Plug in the power cord and press  (power) 
on the control panel.

• Disconnect the machine cable and reconnect 
it.
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Paper feeding problems
Condition Suggested solutions

Paper jams during 
printing.

Clear the paper jam. (See "Clearing paper jams" 
on page 48.)

Paper sticks 
together.

• Check the maximum paper capacity of the 
tray. (See "Print media specifications" on 
page 61.)

• Make sure that you are using the correct type 
of paper. (See "Print media specifications" on 
page 61.)

• Remove paper from the tray and flex or fan 
the paper.

• Humid conditions may cause some paper to 
stick together, replace with a new stack.

Multiple sheets of 
paper do not feed.

Different types of paper may be stacked in the 
tray. Load paper of only one type, size, and 
weight.

Paper does not feed 
into the machine.

• Remove any obstructions from inside the 
machine.

• Paper has not been loaded correctly. Remove 
paper from the tray and reload it correctly.

• There is too much paper in the tray. Remove 
excess paper from the tray.

• The paper is too thick. Use only paper that 
meets the specifications required by the 
machine. (See "Print media specifications" on 
page 61.)

The paper keeps 
jamming.

• There is too much paper in the tray. Remove 
excess paper from the tray. If you are printing 
on special materials, use the manual feeder.

• An incorrect type of paper is being used. Use 
only paper that meets the specifications 
required by the machine. (See "Print media 
specifications" on page 61.)

• There may be debris inside the machine. 
Open the top cover and remove any debris.

Transparencies stick 
together in the paper 
exit.

Use only transparencies specifically designed 
for laser printers. Remove each transparency as 
it exits from the machine.

Envelopes skew or 
fail to feed correctly.

Ensure that the paper guides are against both 
sides of the envelopes.

Printing problems
Condition Possible cause Suggested solutions

The machine 
does not print.

The machine is 
not receiving 
power.

Check the power cord 
connections.

The machine is 
not selected as 
the default 
machine.

Select your machine as your 
default machine in your Windows.

Check the machine for the following:
• The top cover is not closed. Close the top cover.
• Paper is jammed. Clear the paper jam. (See 

"Clearing paper jams" on page 48.)
• No paper is loaded. Load paper. (See "Loading 

paper in the tray" on page 28.)
• The toner cartridge is not installed. Install the toner 

cartridge.
If a system error occurs, contact a service 
representative.

The connection 
cable between 
the computer and 
the machine is 
not connected 
properly.

Disconnect the machine cable and 
reconnect it.

The connection 
cable between 
the computer and 
the machine is 
defective.

If possible, attach the cable to 
another computer that is working 
properly and print a job. You can 
also try using a different machine 
cable.

The port setting 
is incorrect.

Check the Windows printer 
settings to make sure that the print 
job is sent to the correct port. If the 
computer has more than one port, 
make sure that the machine is 
attached to the correct one.

The machine 
may be 
configured 
incorrectly. 

Check the Printing Preferences 
to ensure that all of the print 
settings are correct. (See 
"Opening printing preferences" on 
page 33.)

The printer driver 
may be 
incorrectly 
installed.

Repair the machine software (See 
"Installing USB connected 
machine’s driver" on page 22).

The machine is 
malfunctioning.

• Check the LEDs on the control 
panel to see if the machine is 
indicating a system error. If the 
error cannot be cleared, contact 
a service representative.

• Checking an error message is 
also possible from the Printer 
Status or the Smart Panel on 
your computer.
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The machine 
does not print. 

The document 
size is so big that 
the hard disk 
space of the 
computer is 
insufficient to 
access the print 
job.

Allocate more hard disk space on 
your computer for spooling, and try 
printing.

The machine 
selects print 
materials from 
the wrong 
paper source.

The paper option 
that was selected 
in the Printing 
Preferences 
may be incorrect.

For many software applications, 
the paper source selection is 
found under the Paper tab within 
the Printing Preferences. Select 
the correct paper source. See the 
printer driver help screen. (See 
"Opening printing preferences" on 
page 33.)

A print job is 
extremely slow.

The job may be 
very complex.

Reduce the complexity of the page 
or try adjusting the print quality 
settings.

Half the page is 
blank.

The page 
orientation 
setting may be 
incorrect.

Change the page orientation in 
your application. See the printer 
driver help screen.

The paper size 
and the paper 
size settings do 
not match.

Ensure that the paper size in the 
printer driver settings matches the 
paper in the tray.
Or, ensure that the paper size in 
the printer driver settings matches 
the paper selection in the software 
application settings you use.

The machine 
prints, but the 
text is wrong, 
garbled, or 
incomplete.

The machine 
cable is loose or 
defective.

Disconnect the machine cable and 
reconnect. Try a print job that you 
have already printed successfully. 
If possible, attach the cable and 
the machine to another computer 
that you know works and try a print 
job. Finally, try a new machine 
cable.

The wrong 
printer driver was 
selected.

Check the application’s printer 
selection menu to ensure that your 
machine is selected.

The software 
application is 
malfunctioning.

Try printing a job from another 
application.

The operating 
system is 
malfunctioning.

Exit Windows and reboot the 
computer. Turn the machine off 
and back on again.

Condition Possible cause Suggested solutions

Pages print, but 
they are blank.

The toner 
cartridge is 
defective or out 
of toner.

Redistribute the toner, if 
necessary. 
If necessary, replace the toner 
cartridge.

The file may 
have blank 
pages.

Check the file to ensure that it 
does not contain blank pages.

Some parts, such 
as the controller 
or the board, 
may be 
defective.

Contact a service representative.

The machine 
does not print 
PDF files 
correctly. Some 
graphics, text, 
or illustrations 
are missing.

Incompatibility 
between the PDF 
file and the 
Acrobat 
products.

Printing the PDF file as an image 
may enable the file to print. Turn 
on Print As Image from the 
Acrobat printing options. 

 

It will take longer to print 
when you print a PDF file as 
an image.

The print 
quality of 
photos is not 
good. Images 
are not clear.

The resolution of 
the photo is very 
low. 

Reduce the photo size. If you 
increase the photo size in the 
software application, the resolution 
will be reduced. 

Before printing, 
the machine 
emits vapor 
near the output 
tray.

Using damp 
paper can cause 
vapor during 
printing.

This is not a problem. Just keep 
printing.

The machine 
does not print 
special- sized 
paper, such as 
billing paper.

Paper size and 
paper size 
setting do not 
match.

Set the correct paper size in the 
Edit... in the Paper tab in the 
Printing Preferences. (See 
"Opening printing preferences" on 
page 33.)

Condition Possible cause Suggested solutions
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Printing quality problems
If the inside of the machine is dirty or paper has been loaded improperly, 
there might be a reduction in print quality. See the table below to clear the 
problem. 

Condition Suggested Solutions

Light or faded print • If a vertical white streak or faded area 
appears on the page, the toner supply is low. 
You may be able to temporarily extend the 
toner cartridge life. (See "Redistributing toner" 
on page 48.) If this does not improve the print 
quality, install a new toner cartridge.

• The paper may not meet paper specification; 
for example, the paper may be too moist or 
rough. (See "Print media specifications" on 
page 61.)

• If the entire page is light, the print resolution 
setting is too low or the toner save mode is 
on. Adjust the print resolution and turn the 
toner save mode off. See the help screen of 
the printer driver.

• A combination of faded or smeared defects 
may indicate that the toner cartridge needs 
cleaning. (See "Cleaning the inside" on 
page 46.)

Toner specks • The paper may not meet specification; for 
example, the paper may be too moist or 
rough. (See "Print media specifications" on 
page 61.)

• The transfer roller may be dirty. Clean the 
inside of your machine. Contact a service 
representative.

• The paper path may need cleaning. Contact a 
service representative.

Dropouts If faded areas, generally rounded, occur 
randomly on the page:
• A single sheet of paper may be defective. 

Try reprinting the job.
• The moisture content of the paper is uneven 

or the paper has moist spots on its surface. 
Try a different brand of paper. (See "Print 
media specifications" on page 61.)

• The paper lot is bad. The manufacturing 
processes can cause some areas to reject 
toner. Try a different kind or brand of paper.

• Change the printer option and try again. Go 
to Printing Preferences, click the Paper 
tab, and set type to Thick. (See "Opening 
printing preferences" on page 33.)

• If these steps do not correct the problem, 
contact a service representative.

White Spots If white spots appear on the page:
• The paper is too rough and a lot of dirt from a 

paper falls to the inner devices within the 
machine, so the transfer roller may be dirty. 
Clean the inside of your machine. (See 
"Cleaning the inside" on page 46.)

• The paper path may need cleaning. (See 
"Cleaning the inside" on page 46.)

Vertical lines If black vertical streaks appear on the page:
• The surface (drum part) of the toner 

cartridge inside the machine has probably 
been scratched. Remove the toner cartridge 
and install a new one. (See "Replacing the 
toner cartridge" on page 57.)

If white vertical streaks appear on the page:
• The surface of the LSU part inside the 

machine may be dirty. (See "Cleaning the 
inside" on page 46.)

Black background If the amount of background shading becomes 
unacceptable:
• Change to a lighter weight paper. (See "Print 

media specifications" on page 61.)
• Check the environmental conditions: very 

dry conditions or a high level of humidity 
(higher than 80% RH) can increase the 
amount of background shading.

• Remove the old toner cartridge and, install a 
new one. (See "Replacing the toner 
cartridge" on page 57.)

Toner smear If toner smears on the page: 
• Clean the inside of the machine. (See 

"Cleaning the inside" on page 46.)
• Check the paper type and quality. (See "Print 

media specifications" on page 61.)
• Remove the toner cartridge and then, install 

a new one. (See "Replacing the toner 
cartridge" on page 57.)

Vertical repetitive 
defects

If marks repeatedly appear on the printed side of 
the page at even intervals:
• The toner cartridge may be damaged. If you 

still have the same problem, remove the 
toner cartridge and, install a new one. (See 
"Replacing the toner cartridge" on page 57.)

• Parts of the machine may have toner on 
them. If the defects occur on the back of the 
page, the problem will likely correct itself 
after a few more pages.

• The fusing assembly may be damaged. 
Contact a service representative.

Condition Suggested Solutions
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Background 
scatter

A
Background scatter results from bits of toner 
randomly distributed on the printed page. 
• The paper may be too damp. Try printing 

with a fresh ream of paper. Do not open 
packages of paper until necessary so that 
the paper does not absorb too much 
moisture.

• If background scatter occurs on an envelope, 
change the printing layout to avoid printing 
over areas that have overlapping seams on 
the reverse side. Printing on seams can 
cause problems.

• If background scatter covers the entire 
surface area of a printed page, adjust the 
print quality through your software 
application or in Printing Preferences. (See 
"Opening printing preferences" on page 33.)

Toner particles are 
around bold 
characters or 
pictures

The toner might not adhere properly to this type 
of paper.
• Change the printer option and try again. 

Go to the Printing Preferences, click the 
Paper tab, and set the paper type to 
Recycled.

Misformed 
characters

• If characters are improperly formed and 
producing hollow images, the paper stock 
may be too slick. Try different paper. (See 
"Print media specifications" on page 61.)

Page skew

A a B b CA a B b CA a B b CA a B b CA a B b C c

• Ensure that the paper is loaded properly.
• Check the paper type and quality. (See "Print 

media specifications" on page 61.)
• Ensure that the guides are not too tight or too 

loose against the paper stack.

Condition Suggested Solutions

Curl or wave • Ensure that the paper is loaded properly.
• Check the paper type and quality. Both high 

temperature and humidity can cause paper 
curl. (See "Print media specifications" on 
page 61.)

• Turn the stack of paper over in the tray. Also 
try rotating the paper 180° in the tray.

Wrinkles or 
creases

• Ensure that the paper is loaded properly.
• Check the paper type and quality. (See "Print 

media specifications" on page 61.)
• Turn the stack of paper over in the tray. Also 

try rotating the paper 180° in the tray.

Back of printouts 
are dirty

Check for leaking toner. Clean the inside of the 
machine. (See "Cleaning the inside" on 
page 46.)

Solid Color or 
Black pages

A
• The toner cartridge may not be installed 

properly. Remove the cartridge and reinsert it.
• The toner cartridge may be defective. 

Remove the toner cartridge and install a new 
one. (See "Replacing the toner cartridge" on 
page 57.)

• The machine may require repair. Contact a 
service representative.

Loose toner • Clean the inside of the machine. (See 
"Cleaning the inside" on page 46.)

• Check the paper type and quality. (See "Print 
media specifications" on page 61.)

• Remove the toner cartridge and then, install a 
new one. (See "Replacing the toner cartridge" 
on page 57.)

• If the problem persists, the machine may 
require repair. Contact a service 
representative.

Condition Suggested Solutions
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Common Windows problems
Condition Suggested solutions

“File in Use” 
message appears 
during installation.

Exit all software applications. Remove all 
software from the startup group, then restart 
Windows. Reinstall the printer driver.

“General Protection 
Fault”, “Exception 
OE”, “Spool 32”, or 
“Illegal Operation” 
messages appear.

Close all other applications, reboot Windows 
and try printing again.

“Fail To Print”, “A 
printer timeout error 
occurred” messages 
appear.

These messages may appear during printing. 
Just keep waiting until the machine finishes 
printing. If the message appears in ready mode 
or after printing has been completed, check the 
connection and/or whether an error has 
occurred.

 

Refer to the Microsoft Windows User’s Guide that came with your 
computer for further information on Windows error messages.

Common Linux problems
condition Suggested solutions

The machine does 
not print.

• Check if the printer driver is installed in your 
system. Open the Unified Driver Configurator 
and switch to the Printers tab in Printers 
configuration window to look at the list of 
available machines. Make sure that your 
machine is displayed on the list. If not, open 
Add new printer wizard to set up your 
device.

• Check if the machine is started. Open 
Printers configuration and select your 
machine on the printers list. Look at the 
description in the Selected printer pane. If its 
status contains Stopped string, press the 
Start button. After that normal operation of 
the machine should be restored. The 
“stopped” status might be activated when 
some problems in printing occur. 

• Check if your application is not using a special 
print option such as “-oraw”. If “-oraw” is 
specified in the command line parameter, 
then remove it to print properly. For Gimp 
front-end, select “print” -> “Setup printer” and 
edit the command line parameter.

The machine does 
not print whole 
pages, and output is 
printed on half the 
page.

It is a known problem that occurs when a color 
machine is used on version 8.51 or earlier of 
Ghostscript, 64-bit Linux OS, and has been 
reported to bugs.ghostscript.com as Ghostscript 
Bug 688252. The problem is solved in AFPL 
Ghostscript v. 8.52 or above. Download the 
latest version of AFPL Ghostscript from 
http://sourceforge.net/projects/ghostscript/ and 
install it to solve this problem.

I encounter the 
“Cannot open port 
device file” error 
when printing a 
document.

Avoid changing print job parameters (via LPR 
GUI, for example) while a print job is in progress. 
Known versions of CUPS server break the print 
job whenever print options are changed and 
then try to restart the job from the beginning. 
Since Unified Linux Driver locks the port while 
printing, the abrupt termination of the driver 
keeps the port locked and unavailable for 
subsequent print jobs. If this situation occurs, try 
to release the port by selecting Release port in 
Port configuration window.

 

Refer to the Linux User’s Guide that came with your computer for 
further information on Linux error messages.

Character Voids

A
Character voids are white areas within parts of 
characters that should be solid black:
• If you are using transparencies, try another 

type of transparency. Because of the 
composition of transparencies, some 
character voids are normal. 

• You may be printing on the wrong surface of 
the paper. Remove the paper and turn it 
over. 

• The paper may not meet paper 
specifications. (See "Print media 
specifications" on page 61.)

Horizontal stripes

A a B b C
A a B b C
A a B b C
A a B b C
A a B b C

If horizontally aligned black streaks or smears 
appear:
• The toner cartridge may be installed 

improperly. Remove the cartridge and 
reinsert it.

• The toner cartridge may be defective. 
Remove the toner cartridge and install a new 
one. (See "Replacing the toner cartridge" on 
page 57.)

• If the problem persists, the machine may 
require repair. Contact a service 
representative.

Curl If the printed paper is curled or paper does not 
feed into the machine:
• Turn the stack of paper over in the tray. Also 

try rotating the paper 180° in the tray. 
• Change the printer option and try again. Go 

to Printing Preferences, click Paper tab, 
and set type to Thin. (See "Opening printing 
preferences" on page 33.)

Condition Suggested Solutions
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Common Macintosh problems
condition Suggested solutions

The machine does 
not print PDF files 
correctly. Some 
parts of graphics, 
text, or illustrations 
are missing.

Printing the PDF file as an image may enable 
the file to print. Turn on Print As Image from the 
Acrobat printing options. 

 

It will take longer to print when you print a 
PDF file as an image.

The document has 
printed, but the print 
job has not 
disappeared from 
the spooler in Mac 
OS X 10.3.2.

Update your Mac OS to Mac OS X 10.3.3. or 
higher.

Some letters are not 
displayed normally 
during the Cover 
page printing.

Mac OS cannot create the font during the Cover 
page printing. The English alphabet and 
numbers are displayed normally on the Cover 
page.

When printing a 
document in 
Macintosh with 
Acrobat Reader 6.0 
or higher, colors 
print incorrectly.

Make sure that the resolution setting in your 
machine driver matches the one in Acrobat 
Reader.

 

Refer to the Macintosh User’s Guide that came with your computer for 
further information on Macintosh error messages.
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9.supplies
This chapter provides information about purchasing supplies and maintenance parts available for your machine.
This chapter includes:
• How to purchase
• Available supplies

• Available maintenance parts
• Replacing the toner cartridge

  

 

Available accessories may differ from country to country. Contact your 
sales representatives to obtain the list of available accessories.

How to purchase
To order Samsung-authorized supplies, accessories and, maintenance 
parts, contact your local Samsung dealer or the retailer where you 
purchased your machine. You can also visit www.samsung.com/supplies, 
select your country/region, and obtain information on calling for service.

Available supplies
When supplies reach their lifespan, you can order the following types of 
supplies for your machine:

Model Number

• 104 (MLT-D104S): Available in all regions except those listed in 
Region A and B.

• 1042 (MLT-D1042S): Region Aa

a.Region A: Albania, Austria, Belgium, Bosnia, Bulgaria, Croatia, 
Cyprus, Czech Republic, Denmark, Estonia, Finland, France, 
Germany, Greece, Hungary, Italy, Latvia, Lithuania, Macedonia, 
Netherlands, Norway, Poland, Portugal, Romania, Serbia, Slovakia, 
Slovenia, Spain, Sweden, Switzerland, UK. 

• 1043 (MLT-D1043S): Region Bb: 

b.Region B: China, Bangladesh, India, Nepal, Ukraine, Vietnam. 

• 104 (MLT-D104X): Not available in all regions.
*Refer to your local Samsung website for availability.

To replace a toner cartridge see "Replacing the toner cartridge" on page 57.

 

Depending on the options and job mode used, the toner cartridge’s 
lifespan may differ.

 

You must purchase supplies, including toner cartridges, in the same 
country where you purchased your machine. Otherwise, supplies will 
be incompatible with your machine since the system configuration of 
these vary from country to country.

 

Samsung does not recommend using non-genuine Samsung toner 
cartridge such as refilled or remanufactured. Samsung cannot 
guarantee non-genuine Samsung toner cartridge's quality. Service or 
repair required as a result of using non-genuine Samsung toner 
cartridges will not be covered under the machine warranty.

Available maintenance parts
To avoid print quality and paper feed problems resulting from worn parts 
and to maintain your machine in top working condition, the following parts 
will need to be replaced after printing the specified number of pages or 
when the life span of each item has expired.

Parts Average yielda

a.Yield is affected by operating system used, computing performance, 
application software, connecting method, media type, media size and 
job complexity.

Transfer roller Approx. 30,000 pages ROLLER-TRANSF
ER

Fuser unit Approx. 30,000 pages FUSER

Pickup roller Approx. 30,000 pages ROLLER-PICK UP

To purchase maintenance parts, contact the source where you bought the 
machine. 
Replacing maintenance parts can be performed only by an authorized 
service provider, dealer, or the retailer where you bought the machine. 
The warranty does not cover the replacement of any maintenance 
parts once they have reached their “Average yield”.

Replacing the toner cartridge

 

Click this link to open an animation about replacing a toner cartridge.

When the toner cartridge reaches its estimated cartridge life,
• The Printer Status or the Smart Panel program window appears on the 

computer telling you the toner cartridge needs to be replaced.
• The machine stops printing.
At this stage, the toner cartridge needs to be replaced. Check the model 
number for the toner cartridge used in your machine. (See "Available 
supplies" on page 57.)

Part name
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1. Open the top cover.
2. Pull the toner cartridge out.

3. Take a new toner cartridge out of its package. 
4. Remove the cap protecting the toner cartridge. 

5. Slowly shake the cartridge side to side five or six times to distribute the 
toner evenly inside the cartridge. It will assure maximum copies per 
cartridge. 

 

If toner gets on your clothing, wipe it off with a dry cloth and wash 
clothing in cold water. Hot water sets toner into fabric.

 

Do not touch the drum located in the toner cartridge or imaging 
unit. Use the handle on the cartridge to avoid touching this area. 

6. Hold the toner cartridge by the handle and slowly insert the cartridge into 
the opening in the machine. 
Tabs on the sides of the cartridge and corresponding grooves within the 
machine will guide the cartridge into the correct position until it locks into 

place completely.

7. Close the top cover. Make sure that the cover is securely closed. 
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10.specifications
This chapter covers the machines primary specifications.
This chapter includes:
• Hardware specifications
• Environmental specifications
• Electrical specifications
• Print media specifications
  

 

The specification values are listed below: specifications are subject to change without notice: See www.samsung.com/printer for possible changes in 
information.

Hardware specifications

Item Description

Dimension Height 184 mm (7.24 inches)

Depth 224 mm (8.82 inches)

Width 341 mm (13.43 inches)

Weight Machine with consumables 4.7 kg (10.36 lbs)

Environmental specifications

Item Description

Noise Levela

a.Sound Pressure Level, ISO 7779. Configuration tested: machine basic installation, A4 paper, simplex printing.

Ready mode 26 dB(A)

Printing mode 49 dB(A)

Temperature Operation 10 to 32 °C (50 to 90 °F)

Storage (unpacked) 0 to 40 °C (32 to 104 °F)

Humidity Operation 10 to 80% RH

Storage (unpacked) 20 to 80% RH

Electrical specifications

 

Power requirements are based on the country/region where the device is sold. Do not convert operating voltages. Doing so might damage the device and 
void the product warranty.

Item Description

Power ratinga 110 volt models AC 110 - 127 V

220 volt models AC 220 - 240 V
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Power consumption Average operating mode Less than 270 W

Ready mode Less than 40 W

Power save mode Less than 2.8 W 

Power off mode Less than 0.45 W

a.See the rating label on the machine for the correct voltage(V), frequency (hertz) and type of current (A) for your machine.

Item Description
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Print media specifications

Type Size Dimensions
Print media weight ba

a.If media weight is over 120 g/m2 (32 lbs), load a paper into the tray one by one.

/Capacity

Plain paper Letter 216 x 279 mm (8.50 x 11.00 inches) 60 to 120 g/m2 (16 to 32 lbs bond) 
• 150 sheets of 80 g/m2 (20 lbs 

bond)

60 to 163 g/m2 (16 to 43 lbs 
bond) 
• 1 sheet for manual feeding in 

the tray

Legal 216 x 356 mm (8.50 x 14.00 inches)

US Folio 216 x 330 mm (8.50 x 13.00 inches)

A4 210 x 297 mm (8.27 x 11.69 inches)

Oficio 216 x 343 mm (8.50 x 13.50 inches)

JIS B5 182 x 257 mm (7.17 x 10.12 inches)

ISO B5 176 x 250 mm (6.93 x 9.84 inches) 

Executive 184 x 267 mm (7.25 x 0 inches)

A5 148 x 210 mm (5.83 x 8.27 inches)

Envelope Envelope Monarch 98 x 191 mm (3.87 x 7.50 inches) 75 to 90 g/m2 (20 to 24 lbs bond)
• 1 sheet for manual feeding in the trayEnvelope No. 10 105 x 241 mm (4.12 x 9.50 inches)

Envelope DL 110 x 220 mm (4.33 x 8.66 inches)

Envelope C5 162 x 229 mm (6.38 x 9.02 inches)

Thick paper Refer to the Plain 
paper section 

Refer to the Plain paper section 90 g/m2 (24 lbs bond)
• 140 sheets 

90 to 163 g/m2 (24 to 43 lbs 
bond)
• 1 sheet for manual feeding in 

the tray

Thin paper Refer to the Plain 
paper section 

Refer to the Plain paper section 60 to 70 g/m2 (16 to 19 lbs bond)
• 1 sheet for manual feeding in the tray

Transparency Letter, A4 Refer to the Plain paper section 138 to 146 g/m2 (37 to 39 lbs bond)
• 1 sheet for manual feeding in the tray

Labelsc

c. Smoothness: 100 to 250 (sheffield).

Letter, Legal, US 
Folio, A4, JIS B5, ISO 
B5, Executive, A5

Refer to the Plain paper section 120 to 150 g/m2 (32 to 40 lbs bond)
• 1 sheet for manual feeding in the tray

Card stock Letter, Legal, US 
Folio, A4, JIS B5, ISO 
B5, Executive, A5

Refer to the Plain paper section 105 to 163 g/m2 (28 to 43 lbs bond)
• 1 sheet for manual feeding in the tray

Minimum size (custom) 76 x 183 mm (3.00 x 7.20 inches) 60 to 163 g/m2 (16 to 43 lbs bond) 
Maximum size (custom) 216 x 356 mm (8.50 x 14.02 inches)

b.Maximum capacity may differ depending on media weight, thickness and environmental conditions. 

Tray Manual feeding in the tray
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contact samsung worldwide
If you have any comments or questions regarding Samsung products, contact the Samsung customer care center.

Country/Region Customer Care Center Web Site

ALBANIFA 42 27 5755

ARGENTINE 0800-333-3733 www.samsung.com

ARMENIA 0-800-05-555

AUSTRALIA 1300 362 603 www.samsung.com

AUSTRIA 0810-SAMSUNG (7267864, € 0.07/min) www.samsung.com

AZERBAIJAN 088-55-55-555

BAHRAIN 8000-4726 www.samsung.com

BELARUS 810-800-500-55-500

BELGIUM 02-201-24-18 www.samsung.com/be (Dutch)
www.samsung.com/be_fr (French)

BOSNIA 05 133 1999

BRAZIL 0800-124-421
4004-0000

www.samsung.com

BULGARIA 07001 33 11 www.samsung.com

CANADA 1-800-SAMSUNG (726-7864) www.samsung.com

CHILE 800-SAMSUNG (726-7864) www.samsung.com

CHINA 400-810-5858 www.samsung.com

COLOMBIA 01-8000112112 www.samsung.com

COSTA RICA 0-800-507-7267 www.samsung.com

CROATIA 062 SAMSUNG (062 726 7864) www.samsung.com

CZECH REPUBLIC 800-SAMSUNG (800-726786) www.samsung.com

Samsung Zrt., česká organizační složka, Oasis Florenc, Sokolovská394/17, 180 00, Praha 8

DENMARK 70 70 19 70 www.samsung.com

DOMINICA 1-800-751-2676 www.samsung.com

ECUADOR 1-800-10-7267 www.samsung.com

EGYPT 0800-726786 www.samsung.com

EIRE 0818 717100 www.samsung.com

EL SALVADOR 800-6225 www.samsung.com

ESTONIA 800-7267 www.samsung.com

FINLAND 030-6227 515 www.samsung.com

FRANCE 01 48 63 00 00 www.samsung.com

GERMANY 01805 - SAMSUNG (726-7864 € 0,14/min) www.samsung.com

GEORGIA 8-800-555-555
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GREECE IT and Mobile : 80111-SAMSUNG (80111 7267864) from land line, local 
charge/ from mobile, 210 6897691 
Cameras, Camcorders, Televisions and Household Appliances
From mobile and fixed 2106293100

www.samsung.com

GUATEMALA 1-800-299-0013 www.samsung.com

HONDURAS 800-27919267 www.samsung.com

HONG KONG (852) 3698-4698 www.samsung.com/hk
www.samsung.com/hk_en/

HUNGARY 06-80-SAMSUNG (726-7864) www.samsung.com

INDIA 3030 8282
1800 3000 8282 

www.samsung.com

INDONESIA 0800-112-8888
021-5699-7777

www.samsung.com

IRAN 021-8255 www.samsung.com
www.samservice.com

ITALY 800-SAMSUNG (726-7864) www.samsung.com

JAMAICA 1-800-234-7267 www.samsung.com

JAPAN 0120-327-527 www.samsung.com

JORDAN 800-22273 www.samsung.com

KAZAKHSTAN 8-10-800-500-55-500 (GSM:7799) www.samsung.com

KOSOVO +381 0113216899

KUWAIT 183-2255 www.samsung.com

KYRGYZSTAN 00-800-500-55-500 www.samsung.com

LATVIA 8000-7267 www.samsung.com

LITHUANIA 8-800-77777 www.samsung.com

LUXEMBURG 261 03 710 www.samsung.com

MALAYSIA 1800-88-9999 www.samsung.com

MACEDONIA 023 207 777

MEXICO 01-800-SAMSUNG (726-7864) www.samsung.com

MOLDOVA 00-800-500-55-500

MONTENEGRO 020 405 888

MOROCCO 080 100 2255 www.samsung.com

NIGERIA 080-SAMSUNG(726-7864) www.samsung.com

NETHERLANDS 0900-SAMSUNG (0900-7267864) (€ 0,10/min) www.samsung.com

NEW ZEALAND  0800 SAMSUNG (0800 726 786) www.samsung.com

NICARAGUA 00-1800-5077267 www.samsung.com

NORWAY 815-56 480 www.samsung.com

OMAN 800-SAMSUNG (726-7864) www.samsung.com

PANAMA 800-7267 www.samsung.com

PERU 0-800-777-08 www.samsung.com

Country/Region Customer Care Center Web Site
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PHILIPPINES 1800-10-SAMSUNG (726-7864)
1-800-3-SAMSUNG (726-7864)
1-800-8-SAMSUNG (726-7864)
02-5805777

www.samsung.com

POLAND 0 801 1SAMSUNG (172678)
022-607-93-33

www.samsung.com

PORTUGAL 80820-SAMSUNG (726-7864) www.samsung.com

PUERTO RICO 1-800-682-3180 www.samsung.com

RUMANIA 08010 SAMSUNG (08010 726 7864) only from landline, local network 
Romtelecom - local tariff /
021 206 01 10 for landline and mobile, normal tariff.

www.samsung.com

RUSSIA 8-800-555-55-55 www.samsung.com

SAUDI ARABIA 9200-21230 www.samsung.com

SERBIA 0700 SAMSUNG (0700 726 7864) www.samsung.com

SINGAPORE 1800-SAMSUNG (726-7864) www.samsung.com

SLOVAKIA 0800-SAMSUNG (726-7864) www.samsung.com

SOUTH AFRICA 0860 SAMSUNG (726-7864) www.samsung.com

SPAIN 902-1-SAMSUNG(902 172 678) www.samsung.com

SWEDEN 0771 726 7864 (SAMSUNG) www.samsung.com

SWITZERLAND 0848-SAMSUNG (7267864, CHF 0.08/min) www.samsung.com/ch
www.samsung.com/ch_fr/

TADJIKISTAN 8-10-800-500-55-500 www.samsung.com

TAIWAN 0800-329-999 www.samsung.com

THAILAND 1800-29-3232
02-689-3232

www.samsung.com

TRINIDAD & TOBAGO 1-800-SAMSUNG (726-7864) www.samsung.com

TURKEY 444 77 11 www.samsung.com

U.A.E 800-SAMSUNG (726-7864) www.samsung.com

U.K 0330 SAMSUNG (726-7864) www.samsung.com

U.S.A 1-800-SAMSUNG (726-7864) www.samsung.com

UKRAINE 0-800-502-000 www.samsung.ua
www.samsung.com/ua_ru

UZBEKISTAN 8-10-800-500-55-500 www.samsung.com

VENEZUELA 0-800-100-5303 www.samsung.com

VIETNAM 1 800 588 889 www.samsung.com

Country/Region Customer Care Center Web Site
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glossary
 

The following glossary helps you get familiar with the product by 
understanding the terminologies commonly used with printing as well 
as mentioned in this user’s guide.

802.11
802.11 is a set of standards for wireless local area network (WLAN) 
communication, developed by the IEEE LAN/MAN Standards 
Committee (IEEE 802). 

802.11b/g/n
802.11b/g/n can share same hardware and use the 2.4 GHz band. 
802.11b supports bandwidth up to 11 Mbps, 802.11n supports 
bandwidth up to 150 Mbps. 802.11b/g/n devices may occasionally suffer 
interference from microwave ovens, cordless telephones, and Bluetooth 
devices.

Access point
Access Point or Wireless Access Point (AP or WAP) is a device that 
connects wireless communication devices together on wireless local 
area networks (WLAN), and acts as a central transmitter and receiver of 
WLAN radio signals. 

ADF
An Automatic Document Feeder (ADF) is a scanning unit that will 
automatically feed an original sheet of paper so that the machine can 
scan some amount of the paper at once. 

AppleTalk
AppleTalk is a proprietary suite of protocols developed by Apple, Inc for 
computer networking. It was included in the original Macintosh (1984) 
and is now deprecated by Apple in favor of TCP/IP networking.

BIT Depth
A computer graphics term describing the number of bits used to 
represent the color of a single pixel in a bitmapped image. Higher color 
depth gives a broader range of distinct colors. As the number of bits 
increases, the number of possible colors becomes impractically large for 
a color map. 1-bit color is commonly called as monochrome or black and 
white.

BMP
A bitmapped graphics format used internally by the Microsoft Windows 
graphics subsystem (GDI), and used commonly as a simple graphics file 
format on that platform.

BOOTP
Bootstrap Protocol. A network protocol used by a network client to 
obtain its IP address automatically. This is usually done in the bootstrap 
process of computers or operating systems running on them. The 
BOOTP servers assign the IP address from a pool of addresses to each 

client. BOOTP enables 'diskless workstation' computers to obtain an IP 
address prior to loading any advanced operating system.

CCD
Charge Coupled Device (CCD) is a hardware which enables the scan 
job. CCD Locking mechanism is also used to hold the CCD module to 
prevent any damage when you move the machine.

Collation
Collation is a process of printing a multiple-copy job in sets. When 
collation is selected, the device prints an entire set before printing 
additional copies.

Control Panel
A control panel is a flat, typically vertical, area where control or 
monitoring instruments are displayed. They are typically found in front of 
the machine. 

Coverage
It is the printing term used for a toner usage measurement on printing. 
For example, 5% coverage means that an A4 sided paper has about 5% 
image or text on it. So, if the paper or original has complicated images or 
lots of text on it, the coverage will be higher and at the same time, a 
toner usage will be as much as the coverage.

CSV
Comma Separated Values (CSV). A type of file format, CSV is used to 
exchange data between disparate applications. The file format, as it is 
used in Microsoft Excel, has become a de facto standard throughout the 
industry, even among non-Microsoft platforms.

DADF
A Duplex Automatic Document Feeder (DADF) is a scanning unit that 
will automatically feed and turn over an original sheet of paper so that 
the machine can scan on both sides of the paper.

Default
The value or setting that is in effect when taking a printer out of its box 
state, reset, or initialized.

DHCP
A Dynamic Host Configuration Protocol (DHCP) is a client-server 
networking protocol. A DHCP server provides configuration parameters 
specific to the DHCP client host requesting, generally, information 
required by the client host to participate on an IP network. DHCP also 
provides a mechanism for allocation of IP addresses to client hosts.
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DIMM
Dual Inline Memory Module (DIMM), a small circuit board that holds 
memory. DIMM stores all the data within the machine like printing data, 
received fax data.

DLNA
The Digital Living Network Alliance (DLNA) is a standard that allows 
devices on a home network to share information with each other across 
the network.

DMPr
The Digital Media Printer (DMPr) is a device that allows printing in DLNA 
home network. The DMPr prints a page by combining images with an 
Extensible HyperText Markup Language (XHTML) template. 

DNS
The Domain Name Server (DNS) is a system that stores information 
associated with domain names in a distributed database on networks, 
such as the Internet.

Dot Matrix Printer
A dot matrix printer refers to a type of computer printer with a print head 
that runs back and forth on the page and prints by impact, striking an 
ink-soaked cloth ribbon against the paper, much like a typewriter.

DPI
Dots Per Inch (DPI) is a measurement of resolution that is used for 
scanning and printing. Generally, higher DPI results in a higher 
resolution, more visible detail in the image, and a larger file size.

DRPD 
Distinctive Ring Pattern Detection. Distinctive Ring is a telephone 
company service which enables a user to use a single telephone line to 
answer several different telephone numbers.

Duplex
A mechanism that will automatically turn over a sheet of paper so that 
the machine can print (or scan) on both sides of the paper. A printer 
equipped with a Duplex Unit can print on both sides of paper during one 
print cycle.

Duty Cycle
Duty cycle is the page quantity which does not affect printer 
performance for a month. Generally the printer has the lifespan limitation 
such as pages per year. The lifespan means the average capacity of 
print-outs, usually within the warranty period. For example, if the duty 
cycle is 48,000 pages per month assuming 20 working days, a printer 
limits 2,400 pages a day.

ECM
Error Correction Mode (ECM) is an optional transmission mode built into 
Class 1 fax machines or fax modems. It automatically detects and 
corrects errors in the fax transmission process that are sometimes 
caused by telephone line noise.

Emulation
Emulation is a technique of one machine obtaining the same results as 
another.
An emulator duplicates the functions of one system with a different 
system, so that the second system behaves like the first system. 
Emulation focuses on exact reproduction of external behavior, which is 
in contrast to simulation, which concerns an abstract model of the 
system being simulated, often considering its internal state.

Ethernet
Ethernet is a frame-based computer networking technology for local 
area networks (LANs). It defines wiring and signaling for the physical 
layer, and frame formats and protocols for the media access control 
(MAC)/data link layer of the OSI model. Ethernet is mostly standardized 
as IEEE 802.3. It has become the most widespread LAN technology in 
use during the 1990s to the present.

EtherTalk
A suite of protocols developed by Apple Computer for computer 
networking. It was included in the original Macintosh (1984) and is now 
deprecated by Apple in favor of TCP/IP networking. 

FDI
Foreign Device Interface (FDI) is a card installed inside the machine to 
allow a third party device such as a coin operated device or a card 
reader. Those devices allow the pay-for-print service on your machine.

FTP
A File Transfer Protocol (FTP) is a commonly used protocol for 
exchanging files over any network that supports the TCP/IP protocol 
(such as the Internet or an intranet).

Fuser Unit 
The part of a laser printer that fuses the toner onto the print media. It 
consists of a heat roller and a pressure roller. After toner is transferred 
onto the paper, the fuser unit applies heat and pressure to ensure that 
the toner stays on the paper permanently, which is why paper is warm 
when it comes out of a laser printer.

Gateway
A connection between computer networks, or between a computer 
network and a telephone line. It is very popular, as it is a computer or a 
network that allows access to another computer or network.

Grayscale
A shades of gray that represent light and dark portions of an image 
when color images are converted to grayscale; colors are represented 
by various shades of gray.

Halftone
An image type that simulates grayscale by varying the number of dots. 
Highly colored areas consist of a large number of dots, while lighter 
areas consist of a smaller number of dots.
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HDD
Hard Disk Drive (HDD), commonly referred to as a hard drive or hard 
disk, is a non-volatile storage device which stores digitally-encoded data 
on rapidly rotating platters with magnetic surfaces.

IEEE
The Institute of Electrical and Electronics Engineers (IEEE) is an 
international non-profit, professional organization for the advancement 
of technology related to electricity.

IEEE 1284
The 1284 parallel port standard was developed by the Institute of 
Electrical and Electronics Engineers (IEEE). The term "1284-B" refers to 
a specific connector type on the end of the parallel cable that attaches to 
the peripheral (for example, a printer). 

Intranet
A private network that uses Internet Protocols, network connectivity, and 
possibly the public telecommunication system to securely share part of 
an organization's information or operations with its employees. 
Sometimes the term refers only to the most visible service, the internal 
website.

IP address
An Internet Protocol (IP) address is a unique number that devices use in 
order to identify and communicate with each other on a network utilizing 
the Internet Protocol standard.

IPM
The Images Per Minute (IPM) is a way of measuring the speed of a 
printer. An IPM rate indicates the number of single-sided sheets a printer 
can complete within one minute.

IPP
The Internet Printing Protocol (IPP) defines a standard protocol for 
printing as well as managing print jobs, media size, resolution, and so 
forth. IPP can be used locally or over the Internet to hundreds of 
printers, and also supports access control, authentication, and 
encryption, making it a much more capable and secure printing solution 
than older ones.

IPX/SPX
IPX/SPX stands for Internet Packet Exchange/Sequenced Packet 
Exchange. It is a networking protocol used by the Novell NetWare 
operating systems. IPX and SPX both provide connection services 
similar to TCP/IP, with the IPX protocol having similarities to IP, and 
SPX having similarities to TCP. IPX/SPX was primarily designed for 
local area networks (LANs), and is a very efficient protocol for this 
purpose (typically its performance exceeds that of TCP/IP on a LAN).

ISO
The International Organization for Standardization (ISO) is an 
international standard-setting body composed of representatives from 
national standards bodies. It produces world-wide industrial and 
commercial standards.

ITU-T
The International Telecommunication Union is an international 
organization established to standardize and regulate international radio 
and telecommunications. Its main tasks include standardization, 
allocation of the radio spectrum, and organizing interconnection 
arrangements between different countries to allow international phone 
calls. A -T out of ITU-T indicates telecommunication.

ITU-T No. 1 chart
Standardized test chart published by ITU-T for document facsimile 
transmissions.

JBIG
Joint Bi-level Image Experts Group (JBIG) is an image compression 
standard with no loss of accuracy or quality, which was designed for 
compression of binary images, particularly for faxes, but can also be 
used on other images.

JPEG
Joint Photographic Experts Group (JPEG) is a most commonly used 
standard method of lossy compression for photographic images. It is the 
format used for storing and transmitting photographs on the World Wide 
Web.

LDAP
The Lightweight Directory Access Protocol (LDAP) is a networking 
protocol for querying and modifying directory services running over 
TCP/IP.

LED
A Light-Emitting Diode (LED) is a semiconductor device that indicates 
the status of a machine.

MAC address
Media Access Control (MAC) address is a unique identifier associated 
with a network adapter. MAC address is a unique 48-bit identifier usually 
written as 12 hexadecimal characters grouped in pairs (e. g., 
00-00-0c-34-11-4e). This address is usually hard-coded into a Network 
Interface Card (NIC) by its manufacturer, and used as an aid for routers 
trying to locate machines on large networks.

MFP
Multi Function Peripheral (MFP) is an office machine that includes the 
following functionality in one physical body, so as to have a printer, a 
copier, a fax, a scanner and etc.

MH
Modified Huffman (MH) is a compression method for decreasing the 
amount of data that needs to be transmitted between the fax machines 
to transfer the image recommended by ITU-T T.4. MH is a 
codebook-based run-length encoding scheme optimized to efficiently 
compress white space. As most faxes consist mostly of white space, this 
minimizes the transmission time of most faxes. 
Glossary_ 66



MMR
Modified Modified READ (MMR) is a compression method 
recommended by ITU-T T.6.

Modem
A device that modulates a carrier signal to encode digital information, 
and also demodulates such a carrier signal to decode transmitted 
information.

MR
Modified Read (MR) is a compression method recommended by ITU-T 
T.4. MR encodes the first scanned line using MH. The next line is 
compared to the first, the differences determined, and then the 
differences are encoded and transmitted.

NetWare
A network operating system developed by Novell, Inc. It initially used 
cooperative multitasking to run various services on a PC, and the 
network protocols were based on the archetypal Xerox XNS stack. 
Today NetWare supports TCP/IP as well as IPX/SPX.

OPC
Organic Photo Conductor (OPC) is a mechanism that makes a virtual 
image for print using a laser beam emitted from a laser printer, and it is 
usually green or rust colored and has a cylinder shape. 
An imaging unit containing a drum slowly wears the drum surface by its 
usage in the printer, and it should be replaced appropriately since it gets 
worn from contact with the cartridge development brush, cleaning 
mechanism, and paper.

Originals
The first example of something, such as a document, photograph or text, 
etc, which is copied, reproduced or translated to produce others, but 
which is not itself copied or derived from something else.

OSI
Open Systems Interconnection (OSI) is a model developed by the 
International Organization for Standardization (ISO) for communications. 
OSI offers a standard, modular approach to network design that divides 
the required set of complex functions into manageable, self-contained, 
functional layers. The layers are, from top to bottom, Application, 
Presentation, Session, Transport, Network, Data Link and Physical.

PABX 
A private automatic branch exchange (PABX) is an automatic telephone 
switching system within a private enterprise.

PCL
Printer Command Language (PCL) is a Page Description Language 
(PDL) developed by HP as a printer protocol and has become an 
industry standard. Originally developed for early inkjet printers, PCL has 
been released in varying levels for thermal, dot matrix printer, and laser 
printers.

PDF
Portable Document Format (PDF) is a proprietary file format developed 
by Adobe Systems for representing two dimensional documents in a 
device independent and resolution independent format.

PostScript
PostScript (PS) is a page description language and programming 
language used primarily in the electronic and desktop publishing areas. - 
that is run in an interpreter to generate an image.

Printer Driver
A program used to send commands and transfer data from the computer 
to the printer.

Print Media
The media like paper, envelopes, labels, and transparencies which can 
be used in a printer, a scanner, a fax or, a copier.

PPM
Pages Per Minute (PPM) is a method of measurement for determining 
how fast a printer works, meaning the number of pages a printer can 
produce in one minute.

PRN file
An interface for a device driver, this allows software to interact with the 
device driver using standard input/output system calls, which simplifies 
many tasks. 

Protocol
A convention or standard that controls or enables the connection, 
communication, and data transfer between two computing endpoints.

PS
See PostScript.

PSTN
The Public-Switched Telephone Network (PSTN) is the network of the 
world's public circuit-switched telephone networks which, on industrial 
premises, is usually routed through the switchboard.

RADIUS
Remote Authentication Dial In User Service (RADIUS) is a protocol for 
remote user authentication and accounting. RADIUS enables 
centralized management of authentication data such as usernames and 
passwords using an AAA (authentication, authorization, and accounting) 
concept to manage network access.

Resolution
The sharpness of an image, measured in Dots Per Inch (DPI). The 
higher the dpi, the greater the resolution.

SMB
Server Message Block (SMB) is a network protocol mainly applied to 
share files, printers, serial ports, and miscellaneous communications 
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between nodes on a network. It also provides an authenticated 
Inter-process communication mechanism.

SMTP
Simple Mail Transfer Protocol (SMTP) is the standard for e-mail 
transmissions across the Internet. SMTP is a relatively simple, 
text-based protocol, where one or more recipients of a message are 
specified, and then the message text is transferred. It is a client-server 
protocol, where the client transmits an email message to the server.

SSID
Service Set Identifier (SSID) is a name of a wireless local area network 
(WLAN). All wireless devices in a WLAN use the same SSID in order to 
communicate with each other. The SSIDs are case-sensitive and have a 
maximum length of 32 characters.

Subnet Mask 
The subnet mask is used in conjunction with the network address to 
determine which part of the address is the network address and which 
part is the host address.

TCP/IP
The Transmission Control Protocol (TCP) and the Internet Protocol (IP); 
the set of communications protocols that implement the protocol stack 
on which the Internet and most commercial networks run.

TCR
Transmission Confirmation Report (TCR) provides details of each 
transmission such as job status, transmission result and number of 
pages sent. This report can be set to print after each job or only after 
failed transmissions.

TIFF
Tagged Image File Format (TIFF) is a variable-resolution bitmapped 
image format. TIFF describes image data that typically come from 
scanners. TIFF images make use of tags, keywords defining the 
characteristics of the image that is included in the file. This flexible and 
platform-independent format can be used for pictures that have been 
made by various image processing applications.

Toner Cartridge
A kind of bottle or container used in a machine like a printer which 
contains toner. Toner is a powder used in laser printers and 
photocopiers, which forms the text and images on the printed paper. 
Toner can be fused by by a combination of heat/pressure from the fuser, 
causing it to bind to the fibers in the paper.

TWAIN
An industry standard for scanners and software. By using a 
TWAIN-compliant scanner with a TWAIN-compliant program, a scan can 
be initiated from within the program. It is an image capture API for 
Microsoft Windows and Apple Macintosh operating systems.

UNC Path
Uniform Naming Convention (UNC) is a standard way to access network 
shares in Window NT and other Microsoft products. The format of a 
UNC path is: \\<servername>\<sharename>\<Additional directory>

URL
Uniform Resource Locator (URL) is the global address of documents 
and resources on the Internet. The first part of the address indicates 
what protocol to use, the second part specifies the IP address or the 
domain name where the resource is located.

USB
Universal Serial Bus (USB) is a standard that was developed by the 
USB Implementers Forum, Inc., to connect computers and peripherals. 
Unlike the parallel port, USB is designed to concurrently connect a 
single computer USB port to multiple peripherals.

Watermark
A watermark is a recognizable image or pattern in paper that appears 
lighter when viewed by transmitted light. Watermarks were first 
introduced in Bologna, Italy in 1282; they have been used by 
papermakers to identify their product, and also on postage stamps, 
currency, and other government documents to discourage 
counterfeiting.

WEP
Wired Equivalent Privacy (WEP) is a security protocol specified in IEEE 
802.11 to provide the same level of security as that of a wired LAN. WEP 
provides security by encrypting data over radio so that it is protected as 
it is transmitted from one end point to another.

WIA
Windows Imaging Architecture (WIA) is an imaging architecture that is 
originally introduced in Windows Me and Windows XP. A scan can be 
initiated from within these operating systems by using a WIA-compliant 
scanner.

WPA
Wi-Fi Protected Access (WPA) is a class of systems to secure wireless 
(Wi-Fi) computer networks, which was created to improve upon the 
security features of WEP.

WPA-PSK
WPA-PSK (WPA Pre-Shared Key) is special mode of WPA for small 
business or home users. A shared key, or password, is configured in the 
wireless access point (WAP) and any wireless laptop or desktop 
devices. WPA-PSK generates a unique key for each session between a 
wireless client and the associated WAP for more advanced security.

WPS
The Wi-Fi Protected Setup (WPS) is a standard for establishing a 
wireless home network. If your wireless access point supports WPS, you 
can configure the wireless network connection easily without a 
computer.
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XPS
XML Paper Specification (XPS) is a specification for a Page Description 
Language (PDL) and a new document format, which has benefits for 
portable document and electronic document, developed by Microsoft. It 
is an XML-based specification, based on a new print path and a 
vector-based device-independent document format.
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